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Preface
This User Manual describes the use of the IMDS-a2.
The use of the International Material Data System (IMDS) will not be described here.
In order to learn about the IMDS and to efficiently use it we recommend training
(see https://public.mdsystem.com/web/imds-public-pages/imds-training-courses)
and the training material available:
https://public.mdsystem.com/documents/10906/16811/imds_usermanual_13.0_en.pdf
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Working with the IMDS-a2
Login
To log-on to the IMDS-a2 you can use your IMDS User ID and password. Furthermore, you can select your
preferred language from those available. A reminder, although IMDS prompts are available in several
languages, English is the preferred language for the data fields.

Proxy Settings
When your PC is located in a company network and accesses the internet through a firewall, you must enter the
proxy settings for the IMDS-a2 at the first login from the PC. By clicking “Settings” in the Login dialog you can
access the “Proxy Settings” screen. This action must be performed manually the first time a2 is used on a
computer. The proxy settings will not be captured from Java or your browser.

Tick the “Use the proxy server” checkbox and enter the HTTP and HTTPS proxy server names and ports. If the
information is not available from your browser’s Tools > Internet Options > Connections > LAN Settings tab,
your company’s network administrator can provide you with this information.
The setting “Use alternate network code” should be disabled.
Depending on the configuration of your proxy server, you will receive a dialog similar to the following after
pressing “Login” in the IMDS-a2 Login dialog. You have to enter your internet proxy User ID and password here
– not your IMDS User ID and password. The exact format of the dialog will depend upon the version of Java
Runtime you are using.

If you still experience connection problems after entering the correct proxy settings, select “Use alternate
network code” and try to connect again.
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Announcements
After a successful login, the IMDS-a2 checks for announcements on the IMDS Server. Announcements are
important messages like changes in the GADSL, that you are asked to confirm.
If there are announcements available that you have not yet confirmed, a window like shown in the following
picture:

Announcements are listed one below the other, each one with two options available:
• I want to be reminded of the announcement again on my next log on
• I confirm that I have read the announcement
By default, the first option is set for every announcement.
If this window is open, you cannot work with the IMDS-a2. To close the window, press the “OK” button in the
lower right corner. Be aware, that every announcement, for which you did not select “I confirm that I have read
the announcement” before closing the window, appears again, when you log on the next time.
If you close the announcements by pressing the red “X” button on the top right of the window, you can work with
the IMDS-a2, but no announcement will be confirmed, regardless of what options you selected: Confirmation is
only possible by clicking “OK”.

News
After a successful login and after closing potential announcements, the IMDS-a2 checks for news on the IMDS
Server in the language you selected at login and displays any items in a window similar to the picture below.
The news items typically contain important information about IMDS such as planned downtime announcements,
release notes, Company renamings, etc. …

New items are always displayed. If you do not want repeat showings of an unchanged news entry at login, you
can click on the checkbox “Do not show this news entry again at startup.” This prevents already viewed news
items being displayed at a2 startup, but has no influence on new news entries.
After login, the IMDS-a2 regularly checks for news on the IMDS Server. In case new information becomes
available, the news window is redisplayed to the user, independent of the checkbox setting described above.
If you want to see the current news you can redisplay the news window using the menu Administration > News.
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Main Window
The IMDS-a2 Main Window is the base for all working windows and provides general functionality.

Toolbar Buttons

The Toolbar Buttons either perform an action in the currently active window/tab or open new windows. The
function of each is explained in more detail in the following section.
Create new datasheet – Opens an empty window to create a new datasheet (MDS) or Module.
Save datasheet in IMDS – The currently active MDS/Module is transferred to IMDS and stored there.
Save datasheet as “new version” or “new datasheet” to IMDS – The currently active MDS/Module is
saved and transferred to IMDS as a new version or a new datasheet.
Basic Substance Request – Opens the Basic Substance Request Window, starting with the Search
screen. Here you can search for existing Requests or create Requests.
Request Search – Opens the MDS-Request Window, starting with the Search tab. Here you can search
for existing Requests (either own or received) or create Requests.
In Box – Opens the In Box Window (Received), starting with the Search tab. Here you can search for
received datasheets.
Out Box – Opens the Out Box Window (Sent), starting with the Search tab. Here you can search for sent
datasheets.
Where-Used Analysis– Opens the Where-Used Analysis Window, starting with the Analysis
Criteria/Search tab.
Examiner – Starts analyzing an MDS according to given criteria – this function is available only from the
Ingredients tab.
REACH – Starts analyzing an MDS according to given criteria – this function is available only from the
Ingredients tab.
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Compare MDSs – Starts the MDS/Module comparison – two different MDSs/Modules can be compared.
Start Search – Starts searching the IMDS data with the criteria given in the active Search, In Box or Out
Box Window.
Print – Creates a .pdf file of the Result Table from a specific search. This file can be printed or saved to
the hard drive.
Component Search Window – Opens a component view/update window, starting with the Search tab.
Semicomponent Search Window – Opens a semicomponent view/update window, starting with the
Search tab.
Material Search Window – Opens a material view/update window, starting with the Search tab.
Substance Search Window – Opens a substance view window, starting with the Search tab.
MDS/Module Search Window – Opens an MDS/Module view/update window, starting with the Search
tab.
Open Dashboard Window – Opens the Dashboard window.

Menus
There are seven menu items.
–
–
–
–
–
–
–

File
Search
Optimizer
Add-on Modules
Administration
Windows
Help

For a complete description of the menu items, please see “Summary of Available Functions”.
• File

This menu provides the functionality to create a new MDS/Module or to save an MDS/Module on your local
hard drive or on the IMDS server. It further allows you to open an existing MDS/Module from your hard drive,
to import and create a structure from a .csv file or to delete an own MDS/Module on the IMDS server or mark
one as obsolete/unobsolete. All these functions refer to the active work window and the selected datasheet.
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• Search

This menu option allows the user to open various search windows along with, the In Box and Out Box. It
provides the functionality to execute the respective search and to reset search fields to their default values.
The Regulation Wizard is only visible for users with the appropriate access rights.
• Optimizer

The Optimizer menu provides several functions to optimize your IMDS work. With the Examiner you can
check MDSs according to given criteria either on a single MDS or start the Inbox Automation to check
incoming MDSs (manually or automatically). You can also use the Dashboard to see the status of MDSs or
view a report on a specific datasheet. The Compare MDSs/Modules function allows the comparison of two
Datasheets or Modules and displays all differences. In the Optimizer menu you find also the option to create
and manage your Company-specific Basic Substance Lists.
• Add-on Modules

The Analysis & Reporting module allows unlimited analysis of all material data sheets (MDS) of your
company with extended analysis capabilities.
With the REACH module it is possible to analyze own and/or received MDS that are not editable anymore
(accepted, internal released, published, …) in the up-to-date version for REACH-SHVC. A report on the
results can be printed and REACH contact persons can be searched for. The REACH Analysis is only
available when a REACH module license is active on your user ID. This has to be ordered in addition to the
basic IMDS-a2 license.
The CoChecker module allows you to extract the content of material data sheets (MDSs) into XML files to be
analyzed by tec4U’s CoChecker software.
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• Administration

With this menu option you can change the application language, maintain your personal settings, or open the
news window displaying current IMDS information. As a Company Administrator you can manage your
company’s Contact Persons and Users. With “Profile Maintenance” you can create and maintain the profiles
used by the Examiner and the Inbox Automation. You can also access the Recommendations screen as well
as customize your a2 session with “Options”.
• Windows

The Windows menu option allows you to see all open windows and to reset your window as well as table
settings to the system standard. The current window is marked with a star (*).
• Help

This menu option displays IMDS-a2 version information and allows the user to download the latest IMDS-a2
User Manual. “Adobe Acrobat Reader” is required to view and browse the User Manual as well as the IMDSa2 Terms and Conditions and the IMDS and CDX Terms of Use. Under Video Tutorial you find several
videos on how to use IMDS-a2 functions. The Video Tutorials with regard to an IMDS-a2 menu function are
also available in the corresponding function’s window.
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General functions within the IMDS-a2
Selection of multiple rows

The user can select multiple result rows by using the Ctrl- or Shift key and process them by using Drag and
Drop. They can be dropped into any target that accepts multiple rows like the MDS tree or the a2 Analysis.
Multiple selection is also available in all kinds of search result tables for Component, Semicomponent, Material,
Substance, MDS/Module, In-/Out-Box, Company, MDS Request.
It is also possible to add/remove multiple pre-selected entries in the search result table and the to/from Favorite
list. To add/remove pre-selected entries just select several entries and then press "+ Favorites" or "- Favorites"button.
There is a Video Tutorial available on how to select multiple rows under the menu item Help.

Calendar control

To simplify date input a calendar control is available for all date entry fields. Pressing the button beside the date
field the control appears displaying the current month and highlighting the date. The chosen date will be
transferred into the date field in the correct format. This function is available in the following screens: MDS
Request, In-/Out-Box, REACH Analysis, Component/Semicomponent/Material/MDS-Module -Search windows.

Personalization

Most of the a2 windows save their size information when closed by the user. Opening them again the previous
height and width of the window is restored. The same applies to the column order, column width and visibility of
columns in search result tables.
–
–

Restoring of window sizes when returning to the screen
Restoring table columns and sort order when reusing a certain function

available for the following windows:
Component Search
Semicomponent Search
Material Search
Substance Search
MDB/Module Search
Recipient Data
MDS Request Search
CMD Request Search

MDS Updates
InBox Search
OutBox Search
Where-Used Analysis
Profile Maintenance
Company Search
REACH Contact Person Search
REACH Analysis Frame

View / Update Windows
For each MDS type, a separate view/update window is available. In the following examples the component
window is displayed – other view/update windows are available for Semicomponents, Materials and all
datasheets. There is a separate search/view window for Basic Substances. These windows can be opened
independently from each other and remain in the working area of the IMDS-a2 until the user closes them (e.g.
with the button “Apply & Close”) or exits a2.
Each view/update window contains six tabs – although the Supplier data, the Recipient data and the MDS
Request tabs will not be available for IMDS modules:
• Search
• Ingredients
• Supplier data
• Recipient data
• Analysis
• MDS Request (only available if the MDS is attached to a request)
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The “Search” Tab

This tab allows the user to enter the search criteria. Depending on the field, the search criteria can be typed
(e.g. Article Name) or selected from the drop-down menus (e.g. Origin, Version).
A supplier can be selected by clicking the

Button at the right hand side of the data entry field.

Clicking the Search button in the toolbar executes the search with the selected criteria and the results
are displayed at the bottom of the active window.
Alternatively, the “Search” button in the active window can be used to execute the search.
The results of the search are displayed in a result table.

There is an option to search for multiple part numbers at once. Pressing "…" opens the search dialog:

The following format requirements are applied:
•

There must be one Part/Item No. per line
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•

Max length of 50 characters must not be exceeded (if there are more than 50 char., they are removed)

•

No wildcards supported

•

Invalid or duplicate lines are removed when pressing "OK"

If you tick the “Ignore Spaces” option, the search will ignore all leading, middle and trailing spaces.
The Import button allows you to import a .txt file containing Part/Item No's. The same format requirements as
above are applied.
Clicking the OK Button removes invalid or duplicate lines. The Search window is now in Multiple Part No.search
mode and no entry of a single Part No. is possible.

This mode can be reset to single Part No.search by clicking the Reset icon

.

The order of the columns in the result table may be changed by using the mouse to click on and select the
column heading and dragging the column to another location.

The triangle in the column header shows how the information in sorted – both field and direction. Clicking on the
column header will sort the result table by the selected column in ascending order. A second mouse click will
change it to descending. Module ID / Version are sorted numerically. Within MDSs with the same ID, the version
is sorted.
When searching for a published material, the companies ILI, IMDS-Committee and Stahl und Eisen Liste are
preset as preferred companies and the option “Preferred MDSs” will be checked by default. The Search for
“Preferred MDSs” will return the IMDS Standard MMDSs (ILI Metals, SC Committee, Steel and Iron list) and
published warning-free MMDSs since IMDS Release 10.0. Unless the “all” box is checked or the supplier
companies list is supplemented, the result table only contains materials published by these three companies.
However, this list can be edited and these companies deleted and/or other suppliers added.
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To avoid time-consuming and mostly unnecessary network transfers the amount of transferred search results is
limited to 2,000 result rows in a first try. In case more results are available the user is asked if he really wants to
transfer all results.

Favorites

You can create a personal Favorites list from the search results that you can use in future searches. The
Favorites List is context sensitive and can be recalled with a button click. By clicking on the “Favorites” button in
the Company Search, you can select in which Company Favorites you would like to search.

Favorites in Company Search

There are several types of Favorites that can be used in the Company Search:
Favorites

all companies of your Favorite list

Supplier List

the supplier companies selected in MDS search screens

Recipient List

the recipient companies selected in MDS search screens

all Suppliers

all companies that sent MDSs to your company

all Recipients

all companies that received MDSs from your company
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Filling the Favorites List
With the button
you can add a selected company from the current search result table to the
Favorites List. A Favorites list may contain up to 99 entries.

Using the Favorites List
The button
shows the Favorites List. The current search criteria are not considered but remain in
the search screen. If no Favorites List is found, an error message is displayed.

Removing an Item From the Favorites List
The button

removes a selected entry from the Favorites List.

Favorites Lists are available for the following search screens:
•
•
•
•
•
•
•

Component search
Semicomponent search
Material search
Substance search
MDS/Module search
Company search
MDS Request search

Adding Suppliers Through the Company Search Window
After pressing the Company Search Window Button (
be searched and selected.

), a new window appears from which companies can

Any company in the company search results can be inserted into the Supplier section in the Search tab in two
different ways:
• Selecting a company/Org Unit from the search result and clicking the “Apply” button will insert the company
name into the Supplier section on the Search Tab
• Using the mouse to drag and drop the company name into Supplier area of the Search tab
After the company name is inserted, the company search window can be left open or minimized for later use.
With the button “Apply & Close” the company name is inserted, and the window is closed automatically.
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The “Ingredients” Tab

After a search has been performed, the user can select an MDS/Module from the results and click on the
“Ingredients” tab. The selected MDS/Module information is then requested from the IMDS server and displayed.

The left side shows the selected MDS/Module as a tree. On the right side the folder ‘Details’ shows the detailed
information for the selected Component / Semicomponent / Material / Substance in the tree structure. When first
entering the Ingredients tab, the tree structure is collapsed to show just the Top Node of the tree and the direct
children of that node. Clicking on the
button will expand the entire tree down to the basic substance level.
Clicking on the
in front of a node will expand just that node. Oppositely, Clicking on the
will collapse the
entire tree to the default view – the top node and it’s direct children. Clicking on the
will collapse that node.
If applicable, there may be a “Recyclate”, the “Application” or the “Regulatory Information” tab associated with a
node on the tree. The ”Recyclate” tab contains material dependent recyclate information. The ”Application” tab
contains the applications for the material’s substances, and the “Regulatory Information” tab displays the
relevant regulatory information for the node.
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In the middle of the Details tab the Create Date, Check Date and Release Date are visible and the user can
access the Recommendations screen listing the Recommendations valid at the Check Date. At the bottom all
substances relevant to REACH SVHC Candidate List, REACH Annex XIV or REACH Annex XVII are listed in
the corresponding tables to have an at-a-glance view on REACH substances contained in the MDS. For
substances with a percentage range the maximum percentage is used for calculation. Open the corresponding
substance in the MDS tree by simply double clicking on a substance in the REACH Regulation tables.

The “Ingredients” Buttons

Depending on the type of MDS/Module and whether it is in edit mode, you may have different buttons available
at the top of your structure. The buttons of the ”Ingredients” tab allow to attach existing MDSs/Modules or basic
substances to the tree structure, delete portions of the tree or perform a search of the tree. Sections of the tree
or the entire tree may be expanded or collapsed. The functionality of the buttons is described in the following
table.
When IMDS logic does not allow certain functions, the buttons are inactive or grayed out.
Add a Component reference
opens a new window for searching for an existing component
Add a Semicomponent reference
opens a new window for searching for an existing semicomponent
Add a Material reference
opens a new window for searching for an existing material
Add a Substance reference
opens a new window for searching for a substance
Delete a node
deletes the selected node including the sub-tree(s)
Expand nodes
expands all nodes of the tree
Collapse nodes
collapses all nodes of the tree
Tree search
searches the tree for name, MDS ID, Part-/Item-/Mat-Nr., Node ID, CAS No. deleted
MDSs/Modules/Substances, editable nodes only, Application Code

Basic Substance Lists

The “Basic Substance List” allows you to select a Basic Substance List for filtering your view of the tree
structure. There are several options available. The names of Basic Substances that are in the selected list will
be displayed in a different color.
The default list is the “GADSL” (Global Automotive Declarable Substance List). Declarable substance names
are displayed in blue, while forbidden substance names or substances that are both declarable and/or
prohibited are displayed in red.
The GADSL list is the only one that multi-colors the names. If you select another Basic Substance List filter, the
names of substances in the selected list are displayed in red.
At the end of the common Basic Substance Lists can you find your company’s Company-specific Basic
Substance Lists, if the Company Administrator has created one or more, indicated by the prefix “CS: “.

REACH SVHC candidate substances

Substances that are part of the REACH SVHC candidate list are always displayed underlined in the tree.

Show regulatory information

Once a user ticks this checkbox, several icons will be displayed in the MDS tree showing the state of the
regulatory information. When logging off, the state of this checkbox will be preserved, so the user does not need
to click the checkbox again every time he logs on to the system. Different icons are displayed next to each node
in the tree for which regulatory information is available. The icon is GREEN ( ) if information for all regulations
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is provided and valid, or RED ( ) if no regulatory information is provided. The yellow icon ( ) highlights nodes
that have regulatory information assigned, which are not complete. When modifying the tree (e.g. adding a
substance to the loaded material), the icons are updated accordingly.

The “Details” Tab

In IMDS-a2, the presentation of the MDS data is equivalent to the classic Web-IMDS (except the REACH
information). For the purpose of this document, it is assumed that the user is already familiar with the IMDS
functions and display. In this document, a high-level overview is given. A detailed description of this tab can be
found in the IMDS training manual that can be downloaded from the login screen of the web version of IMDS or
from https://public.mdsystem.com/documents/10906/16811/imds_usermanual_12.0_en.pdf.

The “Recyclate” Tab

Although associated with the parent semicomponent or component node, the Recyclate tab is displayed on the
material level for material classifications of 1 to 5 (all metals and polymer materials).

The “Application” Tab

Although associated with the parent component node, the substance application is required for certain
substance families (lead, mercury, cadmium, hexavalent chromium and PAHs). Applications are necessary for
these substance families and for nickel for the OEMs to fulfill the requirements of Annex II of ELV-directive and
other laws.

The “Regulatory Information” Tab

In the Ingredients tab all regulatory information, including the history, with regard to the IMDS Chemistry
Manager is shown in a separate box.
Since new versions of regulatory information always use the latest released and active version of the MDS as a
reference for the list of contained substances, regulatory information cannot be edited within the Ingredients tab.
Editing regulatory information will only be possible using the Regulation Wizard. A button in the tree toolbar
allows the user to open the Regulation Wizard in a popup window. The opened Wizard will contain all MDSs
referenced, within the opened one, for which the user can enter regulatory information. After applying all
changes made, the MDS view is updated accordingly. Within the regulatory information box, there will be
another button allowing the user to open the Wizard in a popup window. The button will only be available, if the
currently selected MDS belongs to the user's company so he is allowed to modify the regulatory information.
The opened Wizard will only show the currently selected MDS (in its latest active version). After applying all
changes made, the MDS view is updated accordingly.
For accepted supplier MDSs there is also a "Request update of regulatory information" button, which will initiate
a request for an update for the displayed MDS – given that the user's company has not already issued an
update request for this MDS and its regulatory information is in some way incomplete.

Printing of Result Tables
From every Search you can print the results as .pdf report containing the results. In this example we generate a
report of all own Components:
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In the Component Search you look for every own MDS or Module. The list can be sorted by the column headers
either in ascending or descending order. You can either use the File > Print menu item or the print Tool bar
button ( ) to generate the report of the data.
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In the Print options, you can define the header and description of the report. In the footer you may include the
date, User ID and page numbers. As company logo you can use any .gif or .jpg file from your computer. The
number of rows defines which sequential rows of the data will be included in the report.
By clicking OK, the report will be generated as a .pdf-file and opened in the installed pdf-viewer. The report can
then be printed from the pdf-viewer or saved to the user’s hard drive.

Export of Result Tables as Microsoft Excel (XLSX File)
In addition to printing the search results, you may also export the Search results as a MS Excel (XLSX) file. To
save the results as a .xlsx file, use the File > Export as Microsoft Excel (.xlsx) … menu item. You will be asked
where to store your export file.

Export of Result Tables as CSV File
In addition to exporting the search results as MS Excel file, you may also export the Search results as a ‘comma
separated values’ (CSV) file. Although “csv” in the US means “comma separated value”, frequently users will
use a comma in the description which may cause difficulties. In IMDS-a2, the default delimiter is the semicolon
(;), but you may define any character you like in the Administration > Options > Export menu item. (Please see
“Export Parameters” for a description of how to set your separator character.)
To save the results as a .csv file, use the File > Export as CSV file (.csv) … menu item. You will be asked where
to store your export file.
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Creating a New Datasheet
A new datasheet can be created using the respective button
Menu bar and selecting New.

in the toolbar or by selecting File from the

After choosing the type (Datasheet/Module) all Ingredients information can be inserted.

Adding Ingredients Information

All data necessary for creating a new datasheet can be entered in the right side of the ingredients window. The
data fields are equivalent to the data fields in the IMDS browser application.
The following example details a component. The procedures of creating the other MDS types are similar. There
are differences in the data fields that have to be entered, but these fields are the same as the IMDS browser
application.
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Type

Already defined, not changeable

ID / Version

Always 0.01 for new datasheets; is set when transferred to IMDS; not
changeable

MDS Supplier

User’s company; not changeable

Description

Free text to name the new datasheet – should follow IMDS
Recommendations

Part/Item No.

Free text

Measured weight
per item

Free numbers (stated weight of the item)

Calculated weight
per item

Is calculated automatically; not changeable

Deviation

Is calculated automatically; not changeable (deviation between measured
and calculated weight)

Polymeric Part(s)
marked

(If applicable material is attached) Marking of polymeric parts (classifications
5.*). Depending on the weight of the component, the Parts Marking question
may be optional or mandatory.

Preliminary MDS

Yes or no (does this submission reflect a part in development)

Create Date

Shows the date the datasheet was initially created

Release Date

Shows the date the datasheet was released

Check Date

Shows the date the datasheet was last checked

Show
Recommendations

Link to IMDS Recommendations

REACH SVHC CL

Displays details of substances (if contained anywhere in the MDS) listed in
the REACH SVHC Candidate List, REACH Annex XIV, Annex XVII; not
changeable
Lists Name, CAS No., GADSL category (D/P) of the relevant substance and
their portion (%) related to its Article with the Article Name as well as the
portion (%) related to the whole MDS and the weight (g) of the MDS.

REACH Annex XIV
REACH Annex XVII

Using Drag and Drop to Add to Tree

A simple way of adding existing elements to a new datasheet is to use Drag & Drop in IMDS-a2. While you may
use the buttons on the Ingredients page to initiate a search, you can also use the search buttons from the main
toolbar.
Open a Search window of the element you want to add (Component/Semicomponent/Material/Substance) by
using one or more of the following:
• the Main Window buttons or the appropriate button from the Ingredients page
or
• the right mouse button to click on the parent node and selecting the “Add node” option and selecting either
Component Reference, Semicomponent Reference or Material Reference:

An appropriate Search window is opened in which you can search for the requested elements.
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After a successful search, the desired MDSs/Modules can be dragged from the Search Window results and to
the “parent element” within the new datasheet. The general rules of the IMDS online system regarding
combination of elements apply in IMDS-a2.

Adding a New Component or Semicomponent Directly into the Tree

As in the IMDS browser version, components and semicomponents may be added to the tree. These exist only
in the tree structure and do not need to be “released” separately. To create a component or semicomponent in
this manner, right click with the mouse on the parent node and select the “Add node” option. Then select either
Component or Semicomponent

Change status of Semicomponents when attached to a Component

When a Semicomponent is added on the same level with a Component this would violate IMDS
Recommendation 001 (in one structural level only the same kind of elements may be used). In order to avoid
this, a new Component node for this Semicomponent will automatically be inserted.
For Semicomponents, the addition of dimensional data (weight per volume, weight per area, weight per length)
will be possible.
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Creating a Material

The creation of a Material MDS/Module is different than a component and semicomponent. When creating a
material, you first have to select the material classification.

In this screen, only valid Classifications are offered and the desired Classification can be selected. As with the
IMDS browser version, depending on the selected Classification, more screens may appear for entering more
detailed information. Currently, additional screens support the required symbol definition for materials of
classification 5.1.a, 5.1.b, 5.2 and 5.3.
Example: Filled Thermoplastic Materials

The following illustrates further steps for Filled Thermoplastic Materials.

Unfilled Thermoplastics, Thermoplastic Elastomers and Elastomers have similar screens.
The collected information is automatically inserted into the ‘Ingredients’ section.
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Process Chemical Verification Flag

In IMDS, only the data of chemicals which are present in the final product should be entered. Therefore,
process chemicals used during the manufacturing process are not to be entered and the system should prevent
the user from adding those chemicals.
There is a basic substance group “Process chemicals”. Process chemicals are present in the IMDS basic
substance list since in some cases they might be contained in a final part. When the user adds a new substance
to a material, the warning message will appear if the substance is contained in the Process Chemicals
substance group and is present in the material above a certain limit. This limit will be set to 0.1%. Only after the
user confirmation, the selected basic substance will be added to a material MDS with one of the reasons
intended use, reaction residue or impurity.
With this feature, there should be reduced occurrences where the user mistakenly adds a process chemical to
the final part.

Editing Norms and In-house Norms in a Material

To edit the Norm or In-house Norm area, right click on the area and a pop-up menu appears allowing Norms
and In-house Norms to be added or removed.

When you select “Add Norm/Inhouse Norm” another window appears where you must either select a Public
Norm or an OEM Inhouse Norm.

Depending on the selection, you will receive different selections in the pull down.
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In the above example, Public norm was selected so you can use the pull down to find the correct Norm and
enter the code for the norm. Inhouse norms are added in a similar manner:

Referencing an Existing Datasheet

Published, own or received datasheets from the IMDS can easily be referenced (attached to the tree structure)
in the IMDS-a2.
Just open a Search window, perform a search, select the datasheet to be referenced and drag it onto parent
node of the datasheet you are working on. The drag & drop functionality is available within the entire IMDS-a2
application.
When the data sheet is selected, the IMDS-a2 requests this datasheet from the IMDS server and adds it as a
reference with all the information contained. Referencing means that you have visibility to the data but only a
link to the existing data is created.
Referenced datasheets cannot be changed in the active datasheet. In other words, to change a referenced
datasheet, it must be in edit mode and you need to open it in a separate window. Since referenced datasheets
are usually already released, this means to change a referenced datasheet, you must usually make a copy of it
or create a new version.

The “Replace” Function

When editing an MDS/Module, certain referenced nodes in MDS trees can be replaced by other suitable nodes
of the same type (components replace components, semicomponents replace semicomponents, materials
replace materials, substances replace substances). To initiate the Replace functionality, right click the node to
be replaced and then select “Replace” from the list.

This opens up a search window (of the same type as the node to be replaced) with a “Replace” button to use
after selecting the new MDS/Module or basic substance from the search results.
You may also replace suitable nodes by pressing the “Control”-key (“CTRL” on the keyboard) while using drag
and drop. The dragged node will not be added as child of the target node, but it will replace it.
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The “Supplier Data” Tab
The Supplier data refers to the contact for any questions of this datasheet and by necessity would be an
employee of the creating company. The company information is inserted automatically. The Organization Unit
and the Contact Person can be selected from the drop-down menus. The email and phone number of the
selected Contact Person are shown automatically based on data that has been entered by the company’s
Company Administrator using the menu Administration > Contact Person.

The Supplier Data tab must be completed in order to save the datasheet on the IMDS server.
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The “Recipient data” Tab
In this chapter the datasheet can be “released” for use inside your company, sent or proposed to one customer
or multiple customers, or published in IMDS.

The “Internal” Button

If you have not added a recipient, the only options available are Internal and Publish. Internal “releases” the
MDS for use on other datasheets within your company. No changes can be made to a “released” datasheet with
the possible exception of adding recipients. Every user of your company can read and reference the
MDS/Module (with the exception of users with a read-only profile).

The “Publish” Button

The Publish button should rarely be used. Once Published, the MDS is available to anyone with a user ID in the
IMDS system (approximately 150,000 people) to view and use.
For this reason a User profile “User (publish)” is available so that the Company Administrator can grant
publishing rights to a limited amount of users in the company. Other user profiles are not allowed to publish
MDSs. To be able to publish Material MDSs (MMDSs) the user needs to accept a certificate. Furthermore, the
Company Administrator needs to define which type of MDSs (component, semicomponent, material) may be
published by which OrgID inside his company.
In order to prevent an accidental publishing of data, a warning message appears when the Publish button is
selected. The user needs to confirm his choice by selecting the “I agree and want to continue publishing the
MDS” checkbox and click OK from this box to continue. Selecting Cancel will cancel the Publishing of the MDS.

If you have not yet been certificated to publish MDSs, the certification form window will pop up. If you agree to
the stated information, the certification process will start – asking your company administrator to approve your
request for publishing MDSs. When the approval has been done in the system, you are able to publish MDSs.
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The “Send” Button

Until a recipient is added this option will not be available.
To start searching for a recipient company / organization, you can either click on the “Add” button or right click in
the recipient area and select “Add” in the pop-up menu that appears.

The company search window is started and you can search for the recipient company / organization unit. The
result entry can be applied by pressing the “Apply” or the “Apply & Close” button or by dragging the recipient
entry into the recipient table of the component window.
Whenever a new recipient is added, a dialog similar to the following appears. The dialog may be slightly
different if sending to an IMDS Sponsor Company.

In this dialog you can add customer specific information to your MDS that is only visible to the recipient
company. This information is very important for the recipient, because it allows him to map and further process
the MDS. Please fill in this information carefully. Be advised that the recipient will ONLY see the Part/Item No.
and Description from this dialog. Your recipient will not see the information from the top node of your Ingredients
tab. If you are required to make changes to these two fields, you will need to do so on the recipient information
and not the Ingredients tab.
”Forwarding allowed” may be checked if you want to allow your recipient to forward this information directly to
their customer without attaching it first to a tree structure (default setting).
By pressing the “Next” button when sending to an OEM you will get a new window, where you can use the
dropdown menu to
•
•
•
•

Modify Applications
Modify Norms
Modify Parts Marking
Modify Recyclate
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The “Next” button is only available when a Tier 1 supplier is adding an OEM to the recipient list.

Pressing the “Finish” button the dialog is closed and the recipient is added to the recipients table.
The MDS can now be sent to the recipient by pressing the “Send” button.
By invoking Send, the MDS is sent to exactly one recipient company/organization unit. The recipient can either
accept or reject the datasheet. In case he accepts the MDS it gets “released” and no further changes are
allowed. Until it is “accepted” it is in “handshake” mode where changes can be made anywhere in the datasheet
if in “edit” mode (status rejected and version a decimal number). After changes are made, the status is
“modified” and to allow your customer to accept or reject, you must invoke the Send command again.

The “Propose” Button

If you have more than one customer for the MDS or you have a customer that only accepts “proposed” MDSs,
you need to use the Propose button. Ideally, every recipient accepts the MDS without changes. In case one of
the recipients requires changes to the MDS you can either use File > Copy > copy as new datasheet/module to
create a new datasheet for this recipient and send/propose it to him/her again or File > Copy > copy as new
version, make the desired changes and propose to everyone again. However, if the reason for the rejection is
because of data found on the recipient data window, including part/item no. and description, you can make the
required changes and re-propose the same version to that customer.
The selection of the recipients follows the procedure described in the previous section. By clicking the button
“Propose” the MDS is transferred to all recipients in the table that are in “edit” mode.

The “Ignore warnings and proceed” Button in the Check Result List

Prior to releasing, a check is made to see if the datasheet adheres to IMDS rules. If there are too many
warnings, e.g. for very large MDSs you created, you can use the button “Ignore warnings and proceed” to speed
up the Internal / Send / Propose / Publish process. While warnings may be ignored, errors cannot. Should you
decide to ignore warnings and continue anyway, be advised that while these are “warnings” from the IMDS
perspective, your customer may have other business requirements and will probably reject it and you will have
to make corrections anyway.
A list of all errors and warnings can be found on the information pages of the classic IMDS application in the
FAQ section “IMDS Errors and Warnings”: What do the errors in IMDS mean and how can I fix them?
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The “Analysis” Tab
The Analysis tab in the detailed MDS information allows the user to query the Classifications, Materials and
Basic Substances used in the MDS and their aggregated weights and percentages, based on the calculated
weight. The user can choose the desired analysis type in the select box. For Basic Substances a filter for
several Basic Substance Groups is available.

The “MDS Request” Tab
When the MDS is assigned to an MDS Request, you can see here the details of this request:
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Loading and Saving a Datasheet
Saving a Datasheet

You can save your own datasheets / modules on the local hard disk of your PC for later completion. These are
saved in a special a2 format that is only meaningful to a2.
From the File menu, choose one of the following menu items:
• Save To File
• Save To File As
By using the “Save As” option, you can change the name of the file. The saved datasheet will automatically get
the suffix .imds.
A locally saved datasheet does not reside in the IMDS database, but on your local hard disk. No other IMDS
user can access this MDS/Module.
HINT: You can only locally save MDSs / Modules that are owned by you or your company.

Opening a Saved Datasheet

From the File menu, choose the Open From File item.
The file will be read and the MDS/Module will be shown in a new View/Update window.
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Importing Data from MS Excel File
IMDS-a2 provides the possibility to import IMDS-Upload Excel spreadsheets, complying with the format “CSV
File”. If you know the node IDs, you can complete the entire tree structure from the spreadsheet – thus reusing
data that may exist in other systems.

A sample spreadsheet is available on the IMDS Advanced Solutions Service Pages under
https://public.mdsystem.com/web/imds-public-pages/support on the internet.
To import a spreadsheet:
1. From the File menu, select the Import option
2. Choose a file to import: Pressing “Search” a file chooser dialog allows to select the file on your hard disk.
3. Start the import: The import process is launched by pressing the “Import” button. Messages are displayed in
the status area of the dialog.
4. Pressing the “OK” button finishes the import and the imported MDS/Module is displayed in a new window
for further processing in the IMDS-a2.

Saving an MDS to the IMDS Server
Here you can directly transfer your created or changed datasheet into IMDS. You have the following options:

Save to IMDS server
Your changed MDS will be transferred to IMDS with the same version number. This means the datasheet in
IMDS is replaced by what you transfer. The existing datasheet must be in “edit mode” – a decimal version.
Save to IMDS server as … – new version
Your changed MDS is transferred to IMDS with a new version number. This means that the version number is
counted up by one according to the IMDS rules. For being able to do so the MDS/Module must exist in the lower
version on the IMDS server. The new version will be in “edit mode” – a decimal version number.
Save to IMDS server as … – new Datasheet
Your changed MDS is transferred to the IMDS server as new MDS/Module with the version number 0.01.
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You can also see these options by clicking the button “save”; the following options are given:

Copy an Existing IMDS Datasheet
Here you may copy an owned or accepted MDS/Module in IMDS. The copy source is the MDS/Module saved in
the IMDS database. Changes that are not saved are not copied.

Copy as new version

The current MDS/Module will be copied with a higher version number. This means that the version number is
counted up by one according to the IMDS rules. For being able to do so the MDS/Module must exist in the lower
version on the IMDS server. The new version will be in “edit mode” – a decimal number.

Copy as new datasheet/module

The current MDS/Module will be copied with a new module-ID and version number 0.01. For being able to do so
the MDS/Module must exist on the IMDS server.

Placeholders and replacing deleted Nodes

The new enhancement to the Copy function replaces any nodes that cannot be copied because they have been
deleted with a placeholder (a dummy node) that contains the information of the original node. If there are
references to inactivated nodes, these are labeled “(inactivated)” behind the corresponding ID / version
information in the details on the right. Inactivated substances are labeled “(inactivated)” behind the Type: Basic
Substance in the details on the right. For hidden MDSs and basic substances in the product structure tree, the
detail panel has a remark “hidden” in the field “Type”.
The system guides the user to replacements for deactivated or hidden substances after copying a material
which contains this kind of substances. When replacement substances are available for deactivated or hidden
substances, a hint will appear in the substance details. The user can then use the replace function to use the
suggested substance instead of the old one.
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Please right click on the node and select “Replace”:

The MDS Search screen opens and you can search for an MDS to replace the deleted node.

Forward

A received and accepted MDS may be forwarded directly to other recipients without changes. Users who may
want to use this functionality are re-sellers that sell received parts without further changes or logistics partners
who perform “kitting” operations.
There are some rules:
• only accepted MDSs may be forwarded
• no changes may be made to the Ingredients
• a forward-version may not be referenced in other MDSs created by the company (only the originally accepted
MDS can be referenced)
• a forward-version can only be released internally or proposed
• only one Forward copy can be made of an accepted MDS
When the user carries out a search, an MDS is highlighted in the result list and the File  Copy  Forward is
selected, the IMDS-a2 will automatically load the MDS/Module and change to the detail layer. Then, it will
automatically create a forward version of the MDS or display a message to the user when this is not possible
(e.g. because Forwarding is not allowed).
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MDS Request
It is possible to communicate to your supplier the parts they are expected to report on. The supplier can then
easily see in IMDS what needs to be done and what the customer expectations are.
By adding the expected deadlines for reporting as well as internal project designations (commonly known by the
suppliers) you can use IMDS to monitor both project and supplier progress.
The User can access the MDS Request functions either through the Search > MDS Request menu option or the
button on the Tool Bar. You can search for own or received requests. The result table contains several
columns which can be enabled or disabled by right clicking on the table header. All visible columns of a table
can be printed via table printing or exported as CSV / XLSX while invisible columns will not appear.

A new MDS Request can be created by clicking on the create button and then the following window would
appear.

A Request may consist of some or all of the following information fields:
1.
2.
3.
4.
5.
6.
7.
8.

Type of MDS
Assigned MDS
Project name
Company ID / Org Unit ID of MDS supplier
Org-Unit ID of MDS recipient
Deadline date
All recipient specific information (Part/Item No., Description, Drawing number etc.)
Request Status

The only mandatory fields are "part/item number" and the company of the supplier who is expected to provide
the MDS. All other fields are optional. However, if the field is filled in the Create Request, the MDS provider will
have them in the Recipient Data of his MDS and the fields cannot be overwritten. If the fields are empty in the
MDS Request, the MDS provider can enter their own values.
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The Project Name is used to group Requests and to track the progress of the group. Creation of Projects is a
Company Administrator’s function and must be done in the IMDS Browser. Requests can be created for any
type of MDS (Component, Semicomponent, or Material).
To address the company/Org Unit who is going to supply the MDS, the MDS supplier’s company/Org Unit ID is
required. The supplier code is not sufficient since different customers use different coding systems to refer to
suppliers and there are duplicate IMDS company registrations. Because of this, IMDS cannot possibly have a
way of relating a “supplier code” to an IMDS company ID.
Should the MDS Request be sent to an Org Unit, the same rules for apply for accessing the Requests as for
accessing the In Box or the Out Box of an Org Unit – only user IDs with that Org Unit attached to the ID are able
to see the Requests sent to or sent from the Org Unit. It is the Company Administrator’s responsibility to add the
Org Unit to the User ID through menu Administration > User.
When creating an MDS Request, the User can specify to which own org-unit the MDS should be sent. The
deadline date is the date until the Request or expects to receive the MDS.
The supplier can view a list of all customer Requests that he is expected to fulfill until the specified date. Then
he creates the requested MDS and sends it to his customer. All Recipient data fields from the Request will be
copied into the relevant Recipient data fields of the MDS associated with this Request when the supplier
processes the Request (either by associating one of their existing MDSs to the Request or creating an MDS just
for the Request).
The process cycle of an MDS Request is as follows:

MDS Request Process
delete
modify/save

delete

Rejected
reject

send
create/save

delete

Sent / Received

New
detach MDS

Deleted

attach MDS

MDS Request
Attached

delete

Completed
reject MDS

accept MDS

send/propose MDS

Waiting for
acceptance

delete

Request Owner action
Request Receiver action
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The following table details the different States of an MDS Request. The Request status is set automatically. The
user cannot change it.
NEW

Status after Create and Save. The Request is still editable and is
not yet visible to the Request receiver.

SENT/RECEIVED

a. Status after Send. The Request is read-only for the Requestowner; the Request-receiver may see it (as RECEIVED),
assign an MDS or reject the Request.
b. The assigned MDS has been deleted by the Request-receiver.
c. The assigned MDS has been unassigned by the Requestreceiver.

REJECTED

The Request-receiver rejected the Request. A reject reason must
be given.

WORKING

a. The Request-receiver has assigned an MDS, the Requestowner cannot see the MDS ID yet
b. The assigned MDS has been rejected by the Request-owner
c. The assigned MDS has been sent and deleted by the
Request-receiver.

WAITING FOR ACCEPTANCE

The assigned MDS has been sent/proposed by the Requestreceiver and waits in the Request-owner’s In Box.

COMPLETED

The assigned MDS has been accepted by the Request-owner

DELETED

The Request has been deleted by the Request-owner

The Requestor can infer from the status "working", that the MDS supplier is already working on an MDS. This
means he has created an MDS but not sent yet. The Requestor is not able to see the MDS until he receives it in
his In Box.
While this functionality in IMDS is useful, there is no IMDS requirement to use it. The customer and supplier
must determine between themselves whether they are going to use MDS Requests to communicate in IMDS.
MDS Requests shall only be sent to IMDS partners who agree with the usage of this new function.
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CMD Request
DXC Technology included the CMD Request function in IMDS-a2 to enable a larger IMDS user community to
use the Conflict Minerals Declaration (CMD) Request functionality within the Compliance Data Exchange
system (CDX: https://www.cdxsystem.com).
With this function, you can send your IMDS supplier a request for a CMD regarding an existing MDS – either to
a company registered in CDX or one that is not. However, prior to using this function, you must work with your
suppliers (outside of CDX) to jointly agree that you will use CDX to communicate requirements. You will need to
know, in detail, to which company to send the requests. This section details how to use the CMD Request
function.
To find your own, as well as supplier MDSs that contain Conflict Minerals, you can use the Where-Used
Analysis, which is described in the “Using the Where-Used Analysis for Conflict Minerals” chapter.

Pre-Requisites
To use the CMD Request function your company needs to be registered in both IMDS and CDX.
To register your company in CDX, please use the “Register Your Company” function on the Registration menu
on the CDX login page: https://www.cdxsystem.com/cdx. You can review the CDX User Manual to become
familiar with CDX. This is located in the Help menu on the CDX login page.
Although the use of basic CDX functionality, such as creating a CMD or sending a CMD back to the requestor is
free-of-charge, incorporating received CMDs into your own CMD requires a CMD Manager license for a nominal
annual fee.

Using the CMD Request Function
To use the CMD Request function, you must first establish a connection to CDX. Selecting the menu “CMD
Request” opens the window shown below, where you enter your CDX credentials (CDX User ID and the
corresponding CDX password).

Note: To create a CMD Request, your CDX User ID needs to be marked as “CMD Contact” in CDX.
The CMD Request window consists of both a Search tab layer and a Detail tab layer, and represents the CMD
Request Outbox (own CMD Requests sent to suppliers). A CMD Request Inbox view is not necessary because
the IMDS-a2 will not receive any CMD requests. CMD requests as well as CMDs can only be received in the
CDX system.

Search for CMD Requests

In the Search tab layer you can search for your own existing CMD Requests and track their status, or create a
new CMD Request using the respective buttons.
The search parameters and the search result table are combined in one screen for each selectable type. This
screen is divided into a top area and a bottom area. The top area shows the search parameters and the bottom
area displays the search result table.
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You can specify your search by using the following parameters:
Field

Description

Request ID

CMD Request ID

Project

Project name/number to which the request is assigned

Recipient

To search for a certain Recipient click on
the Company / Org.-Unit Search panel.

Supplier Code

Search for CMD Requests with a certain Supplier Code.

Deadline date from –
to

You can search on deadline dates. If so, "from" would be the earliest you would
want to search, and "to" is the last date in the window from which you want to
return.

Request Status

You may filter on the status of the request (new, sent, awaiting acceptance,
completed, rejected). Only one status may be selected per search. Check the
"open requests" box if you want to return all requests that have not been closed
or cancelled.

Template Version

You can search for all CMD Requests you created for a certain Template
Version.

Declaration Scope

You can search for all CMD Requests you created for a certain Declaration
Scope.

Product / Item
Number

You can search for all CMD Requests you created for a certain Product or Item
Number.

. A model dialog pops up to display

Click on “Search” to start the search and it will display all CMD Requests that meet the given parameters in the
result table.
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Parts of a Request

A Request tells a supplier which CMD the Requester expects to receive. The Request consists of the following:
• Set of mandatory CMD attributes (base and recipient specific data)
• Administrative data, which is request-specific
In the request, the Requester indicates which data they expect. Recipient, Due Date and the Product/Item
Number (when you request a CMD on Product Level) are required. All other information is optional.
Please do not place guidance information in the Attributes when creating a request. Requested values
inserted into the assigned CMD data fields cannot be overwritten. If they are empty, CMD suppliers have
the option to enter their own values.

Administrative Data

Administrative data refers directly to the request. This is data the Requester (CMD Recipient) uses to manage
the requests in their company, such as the following:
• Project, which is used to group requests. Projects are created by CDX Company Administrators and are valid
company wide (in the CMD Requester’s CDX company).
• CDX Company / Org-Unit ID and Contact person for the CMD Requester
• Deadline Date, which is the deadline that the CMD Requester expects to receive the requested CMD in CDX

CMD Request Statuses

The Request status describes one of the following:
• A new Request (status: "new")
• The request is sent to a CMD Supplier (status: “sent” = “received” for CMD Supplier)
• The CMD Requester answers a question and sends Request (status: “sent” = “received” for CMD Supplier)
• The CMD Supplier has assigned a CMD but not sent it yet (status: "attached")
• The CMD was sent by the supplier (status: "waiting for acceptance")
• The CMD has been accepted by the requester (status: "completed")
• The Request receiver (CMD Supplier) rejected the request (status: "rejected")
• The Request was cancelled (status: "deleted")

Create a CMD Request

If you use Projects, the first step is to create the project in CDX. For the purposes of this section, we will
assume that you either are not currently using Projects (which is optional), or that your Projects are already
created.
Requests can be created by any User profile (assigned to the CDX user ID) except Read-Only.
You can create a new CMD Request in one of two ways:
• Use the

button in the CMD Request > Search screen

• Click on the
MDS in the result table is marked.

button at the bottom of the Where-Used Analysis screen, when an

Both steps will open the CMD Request Detail screen, where the following Request attributes can be detailed:
Field

Description

Recipient Data
Recipient Company

The CMD supplier who will receive this request (required).

Deadline Date

The date the response is due. This is a required field.

Status

Request Status

CMD Request Data
Template Version
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Field

Description

Declaration Scope

Drop down list of possible Declaration Scope the CMD should cover.

Product/Item Number

This is a required field when Declaration Scope “B. Product (or list of Products)”
is required. Please use the respective buttons or the context menu (right-mouse
click) to Add or Remove one or more Product/Item Number(s).

Company Supplier
Codes

You may enter one or more specific supplier code(s) using the “Add” button or
context menu (existing entries can be removed with the “Remove” button or the
menu). The supplier will not be able to change the code.

Declaration Period
from … to …

You may enter a value to request a Conflict Minerals Declaration for a specific
period.

Requester Data
Requester Company

System generated – CDX name of company generating the request and where
the supplier will send the response to the request.

Organisation Unit

Drop-down list of possible Organization Units to receive response.

CMD Contact

System generated from IMDS User ID of person creating request.

Project

Drop-down list of possible project names to which the request can be assigned.

Comment

Here you can enter additional information for the supplier.

Selecting the Recipient Company
You can search for a company registered in CDX by using the company search function
or you can send
your request to a company not already registered in CDX. If you are not sure, if and how the company is
registered in CDX, you must search for the recipient company – even if the system generated an entry from a
selected MDS.

Use the
button to open the CDX Company Search. Select the correct recipient company and click on “Apply”
or use the “Apply & Close” button to select the company and close the company search window.
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When the CDX Company Search ends without results found, please close the window and activate in the CMD
Request Detail tab “not in CDX registered” – and additional fields appear in the lower area:
Note: Choosing this option will generate an email CMD Request to your supplier contact person, who may then
reply to the email, complete CDX registration for their company, and submit their CMD to your company. Before
using this, please search the companies registered in CDX to ensure that your supplier is not already
registered.

Please fill in the required information for the company to which you want to send the CMD request (all fields with
a red * are required). At the end of the window you can also include a note in the email that the system send for
you. After saving and sending, the Company Administrator you entered will receive an email with an invitation to
register in CDX and send the requested information by using the CDX system.
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Completing the Request
After you finish entering all of the data, use the
button at the end of your request and the system will
perform a check. After the Request has been successfully saved, you will find the following buttons on the lower
right of the screen:
. You can delete your request, change and save again. You then need
to click on Send to send your Request to your supplier. The supplier receives either your CMD Request directly
in the CDX system or a system generated email asking to register in CDX and provide the requested Conflict
Minerals Declaration:

Follow-up on your Requests

To see the status of a CMD Request, you can use the CMD Request Search function. As described above, the
Search Tab layer also represents the CMD Request Outbox. Here you can search for your own CMD Requests
sent to suppliers and also look up their details (including the status).

To find a received CMD related to your CMD Request, you must log-on the CDX system, because CMDs can
only be received in CDX.
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The In Box
In the In Box you see all datasheets received by your company and any Org Units that you have assigned to
your IMDS-a2 ID. Several search criteria are at your disposal and you can view, accept or reject datasheets.

Available search criteria:
Article Name

Your name of the MDS as it was entered by your supplier (will
return all MDSs starting with the entered value)

Part / Item or Material number

Your Part / Item or Material number of the MDS as entered by your
supplier (will return all MDSs starting with the entered value),
searching for multiple part numbers is possible (see The “Search”
Tab)

MDS ID

The IMDS internal Identification number

Version

The IMDS internal version number; ”current” returns the current
version according to IMDS and may not be the most current
version created by your supplier / ”all” delivers all versions of the
MDS that has been sent to your company

Own Org-Unit

The receiving Organization Unit of your company – only available
for Org Units assigned to your ID

Preliminary MDS

If the MDS is marked as a Preliminary MDS

Date

Limits the period of the transmission or last status change

Supplier

The sending supplier

Status

All status fields can be optionally used

all

Activates and de-activates all status options

open MDS

Activates the Status options ”not yet browsed” ”browsed” and
“rejected”

browsed

MDS, which were browsed by you

accepted

MDS, which were accepted by you
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modified

MDS, which were modified by the supplier after your rejection and
not yet re-sent or re-proposed back to you

not yet browsed

MDS, which were not yet browsed by you

rejected

MDS, which were rejected by you

cancelled by sender

MDS, which were cancelled by the sender

in process at recipients

MDS, which are in your own data download and can only be
accepted/rejected through XML code and an AI profile

By default the results of a search are presented in reverse chronological order of the transfer date, i.e. recently
received MDSs are in the upper part of the list. The results may be sorted in any direction or by any displayed
field by clicking on the column header. The fields may also be re-ordered by dragging the column header to the
desired location. For better identification the Part / Item or Material number and the symbol for the MDS type are
included in the result list.
To display the MDS details you can use the tabs ‚Ingredients’‚ Supplier data’ or ‚Recipient data’.
After the Ingredients are viewed a2 communicates this to the IMDS server and MDSs with the status ”not seen“
change to ”seen“. The search results are refreshed with the updated information.
If the MDS status changes (e.g. it gets accepted) and the new status was not part of the search criteria (e.g. the
search was for ”open MDSs“), then the MDS is no longer displayed in the search result list.
The following information is displayed in the result list:
No.

The row number in the result list

Type (Symbol)

Symbol for the MDS type (component, semicomponent, material)

Article Name

Name of the MDS

ID / Version

The ID number of the MDS and the version

Part / Item or Internal Material
number

The respective number of the MDS in your company

transmitted

The date of transfer of the MDS to your company

From Company (Org.-Unit) [ID]

The name of the sending company or Org.-Unit (= your supplier)
and the ID

Status

The MDS status: accepted; modified; not yet browsed; cancelled by
sender; rejected; browsed; in process at recipients (this is only for
recipients using the data download and means, that the MDS is
currently processed in the in-house system of the recipient)

Status Date

The last change date of the MDS

To comp. (Org. –Unit) [ID-No]

The name of the recipient company, org unit if applicable, and
company/org. unit ID.

Supplier code

Supplier code or DUNS number of the supplier company

Drawing Change Level

Recipient information (possibly based on your MDS Request)

Drawing No

Recipient information (possibly based on your MDS Request)

Drawing dated

Recipient information (possibly based on your MDS Request)

Report No.

Recipient information (possibly based on your MDS Request)

Date of Report

Recipient information (possibly based on your MDS Request)

Purchase Order No.

Recipient information (possibly based on your MDS Request)

Bill of Delivery No.

Recipient information (possibly based on your MDS Request)

Node ID

The node ID of the MDS

Entered Weight

Weight entered (for parts only)

Calculated Weight

Weight calculated (for parts only)
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The given weight for a semicomponent

Unit

Unit of the specific weight for a semicomponent

IMDS-a2

All available columns can be enabled or disabled by right clicking on the table header. All visible columns of a
table can be printed via table printing or exported as CSV while invisible columns will not appear.

Accept or Reject MDS
Once you have viewed the MDS and the status changed to seen, you may have the option to accept or reject
the MDS. You will always have the option to reject an MDS. However, with Release 6.0, you will not have the
option to accept an MDS if there are IMDS errors in the structure.
When you click on the Accept button, IMDS checking is started. In the following example, there are some IMDS
Warnings, but no Errors. Should there be any Errors, you will not be given the option of accepting the
datasheet.

If you decide to reject an MDS you have to inform the sender about the reason for denial. The maximum
amount of characters for this field is 10,000 characters.
Should you decide to reject the above, the warnings and errors are copied into the rejection reason where you
can remove those that you do not care about:
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The Out Box
In the Out Box you see all MDSs sent by your company to your customers.

You have several search criteria available.
Article Name

Your name of the MDS as entered by you (will return all MDSs
starting with the entered value)

ID

The IMDS internal identification number

Version

The IMDS internal version number; ”current”’ delivers the newest
version, ”all” delivers all versions of the MDSs

Internal number

Your part, item or material number of the MDS (will return all
MDSs starting with the entered value), searching for multiple Part
numbers is possible (see The “Search” Tab)

External number

Your client’s part, item or material number of the MDS

Preliminary MDS

If the MDS is marked as a Preliminary MDS

Own Org. Unit

The sending Org.-Unit of your company (for those Org Units
assigned to your ID)

Assigned Contact

The assigned Contact Person for your Org.-Unit in your company

Date

Limits the period for the transmission or last status change (format
mm/dd/yy)

Recipient

The receiving customer company / Org. Unit

Status

All status fields can optionally be used

all

Activates all status fields

open MDSs

Activates the status fields ”not yet browsed”, “browsed” and
“rejected”

browsed

MDSs, which were viewed by the recipient

accepted

MDSs, which were accepted by the recipient

modified

MDSs, which were modified by your company after rejection by
the recipient
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not yet browsed

MDSs, which have not been looked at by the recipient

rejected

MDSs, which were rejected by the recipient

cancelled by sender

MDSs, which were deleted by you

forwarded only

MDSs, which were directly forwarded (see Copying a datasheet in
IMDS)

in process at recipients

MDSs, which currently are in the data download at the recipient

obsolete

MDSs, which are obsolete

The result is in reverse chronological order of the transmission date, i.e. recently sent MDSs are in the upper
part of the list. The sort order may be changed by clicking on the column header. Additionally, the order of the
columns can be changed in a similar manner to other search returns.
For a better identification of the MDSs, the part number and the symbol for the MDS type are shown in the
result list.
For displaying the MDS details the following tab layers can be chosen: ”Ingredients”, ”Supplier data” or
“Recipient data”.
The following information is shown in the result list.
Nr.

The row number in the result list

Type (Symbol)

The symbol for the MDS type (component, semicomponent,
material)

Recipient’s Article Name

MDS name

ID / Version

The identification number of the MDS and the version

Internal number

Your part / item or material number of the MDS

Transmitted

The date of the transfer of the MDS to the recipient

to Company (Org. Unit)

The name of the receiving company / Org.-Unit

Status

The MDS status: accepted; modified; not yet browsed; cancelled by
sender; rejected; browsed; in process at recipients (this is only for
customers using the data download and means, that the MDS is
currently processed in the in-house system of the recipient)

Status Date

The last change date of the MDS

from Company (Org. Unit)

The name of the sending company / Org.-Unit

Supplier code

Supplier code or DUNS number of the supplier company

Drawing Change Level

Recipient information (possibly based on your MDS Request)

Drawing No

Recipient information (possibly based on your MDS Request)

Drawing dated

Recipient information (possibly based on your MDS Request)

Report No.

Recipient information (possibly based on your MDS Request)

Date of Report

Recipient information (possibly based on your MDS Request)

Purchase Order No.

Recipient information (possibly based on your MDS Request)

Bill of Delivery No.

Recipient information (possibly based on your MDS Request)

Node ID

The node ID of the MDS

Contact Person

Contact person in the MDS-receiving company

External number

Your client’s part, item or material number of the MDS

Calculated Weight

Weight calculated (for parts only)

All available columns can be enabled or disabled by right clicking on the table header. All visible columns of a
table can be printed via table printing or exported as CSV while invisible columns will not appear.
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Rejection Details
To get to the rejection details, you must go to the Recipient data screen of the rejected MDS and click on the
Modify button at the bottom of the window. By pressing the button “Info” on the Recipient data screen of a
rejected MDS, you will get contact information about the user ID that rejected the MDS.

Summary Reports
In the Out Box, you can create summary reports for certain groups of sent MDSs. The sorting order can be
defined, too.

The following reports are possible to create:
Table Printing

Generic report based on the content of the current detail table.

Sent MDS Statistics Report

Give an overview on all sent MDSs per client, date, and status.

Sent MDS Incomplete Report

This report provides an overview on yet outstanding MDSs that
have been sent.

Enhanced MDS Statistics
Report

This report briefly summarizes on all reports that have been sent
by the user's company, organized by the respective recipients.
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Where-Used Analysis
A detailed description of the Analysis module and how it is used is available at www.mdsystem.com > IMDS
Information Pages > Help > FAQ > System Usage > How can I find where I've used a particular substance
or how can I analyze MDSs or how can the Analysis function be best used? The linked presentation
describes the functionality in the IMDS Web Application.
The IMDS-a2 supports the same analysis functionality as the IMDS Web, but adds a powerful functionality
called “repeated analysis.” It enables you to combine multiple search criteria and find the MDS that complies to
them. The “repeated analyses” is described later in this text.
The Where-Used Analysis also allows you to find (selected either by rule-based selection or by non-standard
selection) all MDSs with a special Application Code (e.g. Lead in Bearing Shells) within a group of MDSs.
Additionally, you can use the analysis function to find MDSs influenced by the last GADSL update.

With the Where-Used Analysis you can search based on the following criteria:
Classification

Search for MDS that contain materials of a certain classification

MDS/Module

Search for MDS that contain a certain MDS/Module

Basic Substance

Search for MDS that contain a certain basic substance

Group

Search for MDS that contain substances of a certain basic
substance group

Basic substance list

Search for MDS that contain substances of a certain basic
substance list

Threshold range

Search for MDSs with range values that exceed the given
"Threshold range" for at least one sub node along with related
supplier information.

Application Code

Search for MDSs that contain a certain application code

Conflict Minerals

Search for MDSs that contain conflict minerals

Confidential Substances

Search for MDSs that contain confidential substances
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GADSL category / REACH
SVHC

Search for MDSs that contain basic substances that match a
GADSL category and/or are part of the REACH SVHC candidate
list.
Choose the category by clicking the corresponding radio buttons
and get only the latest update by choosing “Last … update only”.

Deleted and hidden
MDS/Module

Search for MDSs that contain deleted or hidden MDS/Modules

Deleted and hidden substance

Search for MDSs that contain deleted or hidden substances

Contained Recyclate

Search for MDSs that contain Recyclates

You can either search all the data created or accepted by your company (Rule based) or search a selected list
of MDSs/Modules (Non-standard selection).

Rule Based Selection
Enter search criteria for analyzing all matching MDSs.

Non-standard Selection
Using the Non-standard selection, you create a list of MDS you want to analyze by using Drag & Drop from any
search result (including In Box and Out Box) to the Non-standard Selection section.
A right click on the table opens up a context sensitive menu offering options:
Remove selected MDS/Module
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Remove all MDS/Modules

Completely clears the table (Only available, if you have at lease
one MDS/Module in the table.)

Add MDS/Modules from result
table

Add entries from the result table to the table of MDS to be
analyzed. You can use this e.g. for further analysis. (This option is
only available after you have performed an analysis.)

Add all MDS/Modules from
result tabe

Add all entries from the result table to the table of MDS to be
analyzed. (Only available after you have performed an analysis.)

Once you have entered all parameters, you can start the analysis by clicking the “Analyze” button. If you haven’t
selected the Analysis criteria, the “Analyze” button will not be available. The Analysis defaults to Rule based
analysis of own data.

Repeat Analysis
To add all entries from the result table to the Non-standard selection table allows you to perform a “repeat
analysis”. By using this feature of the IMDS-a2, you are able to analyse MDSs matching more than one criteria.
Example: You can use the repeated analysis if you want to know, which of your own MDSs contain aluminium
alloys as well as lead:
1. Select the “Classification” criteria and choose “2.1 Aluminium and aluminium alloys”
2. In the Rule Based Selection select the origin “own”
3. Press the “Analyze” button to get all your own MDSs containing aluminium alloys.
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4. Select the Non-standard Selection and add the results to Non-standard Selection table. You can do this in
different ways:
a) Press the Button with the arrow pointing upwards
b) Right-click the Non-standard selection table and select “Add MDS/Modules from result table” from the
menu
c) Right-click the result table and select “Add MDS/Modules from result table to Non-standard Selection
table” from the menu
d) Drag and drop the results to the Non-standard Selection table (you can not drag and drop more than
one MDS/Module at a time)
5. Select the “Basic Substance” criteria and choose lead
6. Press “Analyze” again and you will get a list all of your own MDSs containing aluminum alloys and lead
If you want to search the results again for a third criteria, right click the Non-standard selection table and select
“Remove all MDS/Modules” from the menu. The list is now empty and you can add the results again like
explained above.

Using the Where-Used Analysis for Conflict Minerals
The Where-Used Analysis is used to find all MDSs with Conflict Minerals included in your own (as well as
supplier) MDSs. While different parameters can be choosen to define your search, a separate analysis criteria
“Conflict Minerals” is available.

Click the Next button to limit your analysis by specifying further rules – as usually within the Where-Used
Analysis.
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Based on the complexity of the analysis request and the current system load, analysis may take some time. If
your company has a high quantity of complex datasheets, the analysis may exceed the time permitted. If this
occurs, we suggest the user perform multiple searches with fewer results per search using the date-range filters
found in the middle tile. Only one analysis may be scheduled by a single user at one time. After you log off, the
analysis result will no longer be available.
Click the Analyze button to start the analysis, and the result list will show all datasheets which contain Conflict
Minerals (which meet your defined parameters). By clicking on an MDS you can open the Ingredients / Supplier
data / Recipient data screens. When you double click an MDS, opens the Ingredients screen. Within the
Ingredients screen you can use the Basis Substance List “Conflict Minerals” to see all Conflict Minerals included
in your MDS tree structure marked in red.

Once knowing which MDSs contain Conflict Minerals, you can now create a new CMD Request to your supplier
by either:
• Using the

button in the CMD Request function > Search screen

• Clicking on the
button at the bottom of the Where-Used Analysis screen,
when an MDS in the result table is marked.

Both steps will open the CMD Request Detail screen.
Depending on the MDS supplier and/or the contained data sheets in the selected MDS you may see the
following dialogs:
1. You selected an own MDS without any references to other MDSs:

Please note that you cannot send a CMD Request to your own company.
2. You selected an own MDS with one or more referenced MDSs from other companies:
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You can now select the MDS for which you want to create the CMD Request. If you select an MDS from
“IMDS Committee / ILI Metals” or from “Stahl und Eisen Liste” you will see the following error message:

When you select a received or published MDS from your supplier you have not yet established the system’s
connection to CDX. By selecting an MDS and clicking OK, a window opens, where you are asked to enter your
CDX credentials (not your IMDS credentials!):

Please enter your CDX credentials (CDX User ID and the corresponding CDX password) and Login.
The IMDS-a2 establishes a connection to the CDX system in the background.
Note: If your company is not registered in CDX, please click on

first, to register your company.

If you enter wrong logon details, the IMDS-a2 cannot establish the connection to the CDX system. The following
message appears:

Once your CDX credentials have been accepted, the CMD Request window opens with the Detail Tab
displayed with prefilled fields, where possible. This data is extracted from the selected MDS and the MDS
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recipient data. You can change all entries, except for the system-generated Requestor Company and CMD
Contact.
To create your CMD Request and follow-up on your requests, you can now follow the steps described in
chapter “Create a CMD Request.”
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Basic Substance Request
If a basic substance is not yet listed in IMDS, a workflow can be started to request basic substances in IMDS.
The Menu item “Basic Substance Request” can be chosen either from the menu (Search) or the icon

.

If a user accesses the Basic Substance Request screen he will see all requests entered by him. The list shows
name and CAS No. of the substance, the date the request was submitted and the state of the request (open,
completed, deleted). From that screen new requests can be created or existing ones be modified and all
requests can be viewed in detail.

The request form requires some information from the user. Once the request is completed and saved it can be
seen by the user in the screen above.
Should further information be needed by the Chemical Service, the user will receive an e-mail asking for more
information. The request can also be closed by the Chemical Service – in this case, the user will get a
notification e-mail that his request is completed. Closed requests can not be edited anymore.
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MDS Updates
IMDS users have the possibility to identify supplier MDS updates when the supplier MDS is used within the user
company’s MDSs. This feature within the Search menu lists supplier updated MDSs and names the specific
owned or published MDSs which reference an older version of the supplier updated MDS.
After the user selects the Search -> MDS updates menu option and executes the Search, the MDS Updates
screen is shown, providing information about the old and new version of an MDS and in which MDS(s) it is
referenced (default: search for all new supplier entries). The user may also search for specific IDs or names of
parts, or filter the list for the MDS type (own/published/accepted). As with other IMDS screens, from the update
list an MDS can be viewed and edited in different tabs.

Multiple release is possible: To update several MDSs at once, select several rows in the table by holding the
control or the shift key during clicking. This multiple selection is then relevant for the update, release and
remove actions. For all other actions (View old own MDS, Edit updated, view new/old reference), only one entry
should be selected. If more than one is selected, the first entry will be used for the action.
Also, the old and new versions of the referenced MDS are displayed to permit user verification of the pending
update. If the user decides that the change is not relevant and does not want to create a new version, he can
remove the entry from the update list.
To start an action use the menu by right-clicking in the result table or by clicking the Menu button in the lower
right corner.
Note: Updates to this list are processed asynchronously. Therefore, changes are not immediately visible.
The update process is done in two steps. In the first step the update itself is done by replacing the old
references with the new ones and executing a check afterwards. If the check result does not contain error
messages, the MDS can then be released. Otherwise, the MDS can be processed manually to correct the
errors. For convenience, multiple MDSs can be processed (updated and released) at once.
* The old version for published or owned MDSs is the previous version number.
* The old version for accepted MDSs is the previously accepted version number.
Every user can use the MDS Update search without running an analysis. Processing the list entries can be
disrupted and continued later at any time until all entries are processed. The update list will only be generated
for new updates which occur after this design has been implemented (with Release 9.0). There will be no
retroactive analysis for legacy data updated in the past.
When using the MDS update functionality to create new versions of MDSs, the updated references will be
replaced accordingly. However, a new version can still be created with the existing IMDS functionality. The
check procedure will check if relevant updates of referenced MDSs are available. If this is the case, a warning
message for the relevant referenced MDS will be displayed. When the system detects an old version and the
user wants to replace it, the replace button will automatically locate the current and replace the old version with
the current version.
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Regulation Wizard – IMDS Chemistry Manager
Only users with Chemistry Manager Access will be able to see and use this menu item to view, modify and
create regulatory information on their MDSs. The access right can be set by a company administrator in the
user administration screen. Users without the right will be able to request the right in the Personal Settings
menu.
When searching for substances or looking at them in the MDS ingredients screen, regulatory information is only
shown if the user has the Chemistry Manager Access rights.
Using the Regulation Wizard the user can search for MDSs that contain regulation-relevant data and directly
modify it without loading the MDSs themselves. Users will be able to display multiple MDSs at once to modify
the regulatory information for all contained relevant references.
This wizard is available in the "Search" menu offering a search screen similar to the general Module/MDS
search with additional regulation relevant information. The user will be able to search for specific MDSs he
wants to enter regulatory information for or request an update of regulatory information. The search result only
contains the latest released and active versions of MDSs for which the regulatory information can be entered. If
regulatory information can be entered for child nodes, the parent MDS is also available in this list.

The following search criteria will be available (it will not be possible to search for data in older versions of
regulatory information):
• The "Name, ID, Version, Date, Regulatory Info Status" and "Supplier MDSs, Own MDSs/Modules" criteria
boxes look and work the same way as in any other MDS search. They are used to search for MDSs visible to
the user that contain references to MDS which contain regulatory information (anywhere in their ingredients
tree).
• The box “Regulatory Information” is used to define search criteria for the regulatory information contained
within the MDS references inside the ingredients tree. The user can select which regulation to search for.
Depending on the selection, some of the available search fields change while others are always present.
• The “Regulation Request” criteria box allows the user to further narrow down the search by only searching for
regulatory information for requests for updates that have been received or sent.
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Loading Regulatory Information for MDSs
The search result allows multiple selection (CTRL or CTRL+A for “select all”). Via right mouse click on a marked
MDS, the user can select the "Edit own Regulatory Information" or "View own Regulatory Information" option.

Selection of one of these options opens the second tab “Regulatory Information" in the Regulation Wizard
showing all references to own MDSs and own child nodes in the selected MDSs, for which the user can enter
and modify the regulatory information. If the user selects the "View supplied Regulatory Information" option
(only available for MDSs with ownership “supplied”), the "Regulatory Information" tab will show only references
to foreign MDSs and the references within them.
All regulatory information visible in the search result table can also be downloaded as MS Excel file. There are
three different ways to create such a report:
First, the user can create a report for specific MDSs by using the “Download Regulatory Information” option in
the context menu (right mouse-click).
Second, the “Download all” option in the context menu allows the user to download the regulatory information
for all MDSs that are found with the current search criteria.
Third, the “Download Combined REACH Regulatory Information” option provides the complete Regulatory
Information for REACH Semi/Component including component, material and substances answers for the
selected MDS. This option is available in the context menu and via the new button "Combined Reach
Download" next to the “Search” button.
In the Excel file there will be one line for each child regulatory information (e.g. for each BPR substance inside a
material or for each REACH material inside a component). The columns containing the parent information will
contain the same information for each of these lines. The report also contains information about the top MDS
(the one that can be found in the wizard). Since each top MDS can contain multiple parent MDSs, its
information will be duplicated as well.

Editing own Regulatory Information
In the Regulation Wizard, the user can select a regulation for which he wants to enter the data. By clicking on
“Search” he is then presented with an overview of all MDSs and their relevant child nodes and references.
Nodes and references for which no regulatory information has to be entered are not displayed in this view.
Nodes and references for which regulatory information is now required (e.g. because a substance has been
added to the regulation substance group) will be shown.
Clicking on “Edit own Regulatory Information” opens the Regulatory Information tab. For each MDS containing
relevant data (e.g. an MMDS containing BPR-relevant substances) a single row is displayed in a table with all
the contained references. Depending on the regulation, different fields can be filled in for the parent MDS and
the child references.
Since the table can contain a very huge amount of data,the user will be able to filter for certain criteria. The
following filters will be available above the table:
• Cas No.
• Substance Group
• Date of last updates
• Product Types (for BPR regulation type)
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REACH Semi-/Component

REACH Material

BPR

If a data set (e.g. for Biocides, a data set includes the Material plus its contained substances) has no editable
version of the regulation, the fields are displayed in read only mode.
In this case, a "create editable version" button will be shown in the row of the parent MDS. By clicking this
button, the user can create a new editable version, which contains the copied data of the latest released
version.
The created editable regulation version is automatically adapted to the latest MDS version: If the original
regulatory information was released for a MDS version which included additional references (e.g. substances)
which are no longer included in the latest version, these references are automatically removed from the
regulation. If there are new references, they are added accordingly. After doing this, all fields for this data set
become enabled.

Releasing Regulatory Information
You can release every single entry with the respective button in the row. Below the editable regulatory
information tables, a "Release all" button is available. It triggers a check to validate all information entered.
Similar to the confirmation dialog when releasing MDSs, the user is then asked to confirm the release. If there is
at least one data set with erroneous data, the user can choose to "Only release regulatory information without
errors", which will leave the erroneous data sets unaffected.
The check results will be displayed similarly to the results of an MDS check as a table at the bottom of the
screen. For each MDS or substance listed in this table, an error icon will be shown in the corresponding line of
the wizard table. When double clicking a row in the check result table, the wizard automatically scrolls to the
appropriate row.

Viewing foreign Regulatory Information and Requesting Updates
If the user has searched for Regulatory Information with Ownership “supplied” and selected "View foreign
Regulatory Information", the data tab looks very similar to what has been described above, except all fields are
read-only and there are no "release" or "release all" buttons.
Instead, a "request update of regulatory information" column is shown with a button where applicable, which will
initiate a request for an update for the selected MDS. This button is not available if the regulatory information
has been filled out completely for the latest MDS version or if the user's company has already requested an
update for this MDS's regulatory information.
Additionally the same information as shown in the ingredients tab will be shown for each MDS row.
If an MDS occurs multiple times in the table, all its "request update" buttons are synchronized. This means: if
the user presses one of them, all are automatically disabled because a request cannot be issued a second time.
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IMDS-a2 Examiner
While IMDS classic performs certain checks at the time the MDS or Module is “released”, if the check returns
only a warning message, the message can be ignored and the MDS/Module released. Additionally, some items
that may be important to a customer aren’t incorporated into the IMDS checks and in the browser version of
IMDS, the checks are not made on a “released” MDS. Hence, the development of Examiner.
The Examiner helps you to check if your own or received datasheets fulfill certain criteria. IMDS-a2 has several
checks programmed into the system and several of these can be configured with user-defined parameters.
All Examiner checks are optional. For this reason the Examiner only generates information messages, but no
errors or warnings as IMDS Classic does e.g. before releasing a datasheet. The sole exception is the check
“IMDS Default checks” - this check is available in the Examiner and executes the same checks as the browser
version of IMDS. If Inbox Automation is used, the user has the option of flagging critical checks (e.g. part
number, supplier code) for automatic rejection.
All requirements that exceed the standard checks in the browser version of IMDS are customer dependent and
must be agreed upon between supplier and customer.

Examiner Profiles
Before using the Examiner, you must first define what you want to check for. This can be done under
Administration > “Profile Maintenance”.

You have the option of using an Examiner Profile that you created yourself, or one that has been created by
another user in your company or a user in another IMDS company.

Creating an Examiner Profile

The Profile Maintenance window now looks similar to other a2 windows with a Search tab, a Detail tab, and a
Recipient tab. The Search tab allows you to find existing Examiner profiles that are visible to you. The Detail
tab allows you to view the details of the Profile. The Recipient tab allows you to send the profile to other IMDSa2 users.

Clicking on the icon
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When you click on the Create button, you open a blank Detail tab:

You need to give the profile a name and should give it a description. To add a check to the profile, select “Add”
to add a new check to the list for the current profile. Should the check require user-defined parameters, highlight
the check in the Quality Checks in Profile area of the screen and the parameter screen on the right will
become available for editing. An Examiner profile can have as many checks as you want. Just keep highlighting
the check in the “Add” window and double click on the check to add to the profile. Should you want to remove a
check, highlight the check in the Quality Checks in Profile area of the screen and click on “Remove”.
The following table contains a list of available checks:
No.

Check

Description

1

IMDS Default Checks

All checks the IMDS system provides.
These checks are dependant on the ownership and the changeability of
the MDS/Module.
For example all IMDS Classic checks will be executed against a MDS in
Version 0.01 that is owned by your Company.
In case you execute the IMDS Classic check in the In Box against a
received MDS, only the checks valid for read-only MDS are executed.
As a result of these checks, error and/or warning messages are
displayed.

2

Tree level check

Recommendation 001 test - check that all MDS/Module types that are
children of the same parent node are the same.
This check iterates over all nodes in the MDS tree and verifies that all
children of the current node are of the same MDS type (Component,
Semicomponent, Material or Substance).
When a parent node has different types of children, an information
message is displayed.

3

Joker & confidential
substance check

Check if amount of Jokers and confidential substances exceed a given
limit.
This check iterates over every substance in the MDS tree that is defined
as Wildcard/Joker or is marked as confidential and sums up it’s weight.
Then the proportion (in %) of this aggregated weight compared to the
complete weight of the MDS/Module is calculated.
If this proportion exceeds the percent value in the parameter “Limit (in
%)” an information message is displayed.
Note: This is not the same as the Recommendation 001 guidelines.

4

Confidential
substance reference
check I

Check if confidential substances are referenced.
This check iterates over every substance in the MDS tree and displays
an information message when a confidential substance was found.
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No.

Check

Description

5

Confidential
substance reference
check II

Check if confidential substances are referenced over a defined limit.
This check iterates over every substance in the MDS tree and compares
it’s proportion (in %) with the amount of the complete MDS/Module.
If the proportion exceeds the percent value in the parameter “Limit (in
%)” an information message is displayed.

6

Tolerance check

Check if measured and calculated weight are within the given tolerance.
This check iterates over every Component in the MDS tree and
compares it’s deviation (in %) with the percent value in the parameter
“Tolerance (in %)”.
If the Components deviation exceeds this parameter an information
message is displayed.

7

Application check

Check if applications are defined for all application relevant substances.
This check iterates over every Application relevant Substance in the
MDS tree and checks if an Application has been assigned to it.
In case no Application is assigned an information message is displayed.

8

Plastic/Metal check

Check if symbols (for plastics) and Std. Material No. (for metals) are
filled.
This check iterates over every Material in the MDS tree. When it has a
Metal Classification (1.x, 2.x, 3.x, 4.x) it is checked that the field
“Standard Material Number” is filled. In case of a Plastic Classification,
which forces in the web application the use of the symbol wizard (5.1 a,
5.1 b, 5.2, 5.3) the field “Symbol” must be filled.
When the field is empty an information message is displayed.
By setting parameters IMDS standard materials can be included in or
exluded from the check.

9

Classification check

Checks that a Classification according to SC90 requirements has been
assigned to every Material.
This check iterates over every Material in the MDS tree and verifies that
a Classification is assigned to the Material.
In case such an assignment is missing an information message is
displayed.

10

Part Number check

Check for correct part number.
This check compares the Part/Item Number of the Component
MDS/Module against user-defined patterns. These patterns are defined
by parameters and can consist of the following characters:
9 : Numbers 0,1,2,3,4...,9
A : Uppercase characters A-Z
a : Lowercase characters a-z
x : Characters A-Z, a-z
! : Characters and numbers A-Z, a-z, 0-9
A pattern AA-9999-aa would allow Part/Item Numbers like MB-3109-uz
or XX-1234-yy .
In case the Part/Item Number does not comply to the given patterns an
information is displayed.
Remark:
For Semicomponent MDS/Modules the Item/Mat. No will be checked
instead, for Material MDS/Module the Internal Mat.-No.
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No.

Check

Description

11

Parts Marking check

Check for correct Parts Marking.
This check verifies if the Parts Marking question has been answered if
the Component MDS/Module is relevant for Parts Marking.
The entire MDS tree structure is checked for polymeric marking,
not only the top node.
In case it was not answered an information message is displayed,
independent of the weight of the relevant material.
Remark:
In case the weight exceeds defined thresholds the IMDS Default Check
displays an error message when executed.

12

CAS No. check

Check if every Substance has a CAS No.
This check iterates over every Substance in the MDS tree and verifies
that the CAS No. is not empty and does not contain a “-“ or “#”
character.
In case such a Substance is detected an information message is
displayed.

13

Verify Part number
against a Microsoft
Excel sheet

– deprecated; please replace by check no. 37 –

14

Verify Part number
against data source

Compares the Part number against Part numbers out of a given data
source (e.g. Oracle, MS SQL, MS Access, ...). May also be combined
with another field (e.g. IMDS company ID)
This check compares the Part/Item Number of the Component
MDS/Module against many Part/Item Numbers out of any “ODBC
Datasource”. This might be an Oracle, MySQL or MS SQL database
table, but it could also be a Microsoft Access database. The only
requirement is that the database must be installed as a ODBC
Datasource on your local PC.
You also have to define the SQL statement to search your
MDS/Modules Part/Item Number in the given Datasource.
If the MDS/Modules Part/Item Number does not occur as result of the
search, an information message is displayed.
Remark:
For Semicomponent MDS/Modules the Item/Mat. No will be checked
instead, for Material MDS/Module the Internal Mat.-No.
The installation process of the Datasource and the necessary
parameters are described later in this manual. (See “Check Against
ODBC”)

15

Joker & confidential
substance check
(as in Rec. 001)

Check if amount of Jokers and confidential substances exceed the
recommended limit of 10% on each Material as described in
Recommendation 001.
This check iterates over every substance in the MDS tree that is defined
as Wildcard/Joker or is marked as confidential and sums up it’s weight
on the Material node above.
Then the proportion (in %) of this aggregated weight compared to the
weight of the Material is calculated.
If this proportion exceeds 10% an information message is displayed.

16

Trade name check

Checks that every material has a Trade name. The Trade name field in
the material is checked for an entry. If no entry is found, an informational
message is displayed.
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No.

Check

Description

17

Norm check

Checks that every material has at least one public norm or inhouse
norm.
If no entry is found, an informational message is displayed.

18

Prohibited
substances check

Checks if prohibited substances are used.
Every material that contains a prohibited substance will be marked.

19

Standard Material
Supplier Check

Marks every Material that is not published by an IMDS Committee
company (Stahl und Eisen Liste, IMDS Committee, or IMDS Committee/
ILI Metals).
The check can be limited to check only Materials of Classification 1-4
and/or Classification 7.2/7.3.

20

Default Name Check

Flags every node, where a default name is used, that is: the name starts
with “Copy_”, “Kopie_”, “Teil_”, “Component_”, “Halbzeug_”,
“SemiComponet_” or “Material_”.

21

Substance ranges
check

Flags every substance using a range, where the delta (max – min) is
greater than a user defined value.
Note: The max-min value is the same regardless of material
classification. This is not the Recommendation 001 check for substance
ranges.

22

Check for
recommendation
compliance of ranges

Flags every range, which does not comply with ranges allowed by the
IMDS recommendations.
Note: This is the Recommendation 001 range check.

23

Invalid material
classification check

Checks if a material is using a invalid material classification (all
classifications which are no longer used example : 1.2, 5.1, 5.4, etc .. )

24

Check for deleted
and hidden
MDS/modules

Iterates over the complete MDS tree and flags deleted and hidden MDS
or Modules references.
This check can be used in combination with the “Deleted and hidden
MDS/Module” Analysis function to investigate the MDS/Module in detail
after the Analysis run.

25

Check for deleted
and hidden
Substances

Iterates over the MDS tree and flags deleted and hidden Substances.
This check can be used in combination with the “Deleted and hidden
Substance” Analysis function to investigate the MDS/Module in detail
after the Analysis run.

26

Check for correct
supplier code

Checks if the supplier code matches a given pattern.
This check compares the supplier code of the MDS/Module against
user-defined patterns. These patterns are defined by parameters and
can consist of the following characters:
9 : Numbers 0,1,2,3,4...,9
A : Uppercase characters A-Z
a : Lowercase characters a-z
x : Characters A-Z, a-z
! : Characters and numbers A-Z, a-z, 0-9
A pattern AA-9999-aa would allow supplier codes like MB-3109-uz or
XX-1234-yy .
In case the supplier code does not comply to the given patterns an
information is displayed.
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No.

Check

Description

27

Check for filled
remark field in
Material MDS

Checks if the remark field of a Material MDS contains a comment that
should be checked manually.

28

Preliminary MDS
Check

Iterates over the MDS tree and flags preliminary MDSs or Modules.

29

New version check

Check for new versions of referenced MDSs.
Every referenced MDS or module in the tree is checked for new
available versions. The newest version for own, published or received
references is mentioned in the information message.

30

Duty-to-declare
substance reference
check

Check if duty-to-declare substances are referenced over a defined limit.
This check iterates over every substance in the MDS tree and compares
its proportion (in %) with the amount of the complete MDS/Module.
If the proportion exceeds the percent value in the parameter “Limit (in
%)” an information message is displayed.

31

Prohibited substance
reference check

Check if prohibited substances are referenced over a defined limit.
This check iterates over every substance in the MDS tree and compares
its proportion (in %) with the amount of the complete MDS/Module.
If the proportion exceeds the percent value in the parameter “Limit (in
%)” an information message is displayed.

32

SVHC substance
reference check

Check if SVHC substances are referenced over a defined limit.
This check iterates over every substance in the MDS tree and compares
its proportion (in %) with the amount of the complete MDS/Module.
If the proportion exceeds the percent value in the parameter “Limit (in
%)” an information message is displayed.

33

Verify MDS
references against a
Microsoft Excel Sheet

Verifies if MDS references are or are not contained in a Microsoft Excel
Sheet.
Every MDS or module reference in the tree is compared to entries in a
column in an Excel Spreadsheet. The file can be selected with a file
open dialog. Either the Part/Item/Mat.-No., the module ID or the node ID
can be compared. Additionally it can be defined if the reference should
occur in the excel sheet or not. Depending on the selection, an
information message is displayed if the reference was or was not found
in the excel file.
The column in the sheet is specified by a column number, starting with
1. A column header should not be used.

34

ELV heavy metals
Check

Check if substances of the ELV heavy metals group are referenced.
This check iterates over every substance in the MDS tree and displays
an information message when a substance of the ELV heavy metals
group was found. Related substance groups are: Lead or its
compounds, Chromium(VI)-salts, Mercury or its compounds, Cadmium
or its compounds.
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No.

Check

Description

35

Verify Substances
against a Microsoft
Excel Sheet

Verifies if MDS has substances which are or are not contained in a
Microsoft Excel Sheet.
Every MDS or module substance in the tree is compared to entries in a
column in an Excel Spreadsheet. The file can be selected with a file
open dialog. Either the Node ID or the CAS-No. can be compared.
Additionally it can be defined if the substance should occur in the excel
sheet or not. Depending on the selection, an information message is
displayed if the substance was or was not found in the excel file. The
column in the sheet is specified by a column number, starting with 1. A
column header should not be used.

36

Recyclate Check

Checks for filled recyclate information and/or exceeded thresholds
(based on the given parameters).
If the proportion exceeds the percent value in the parameter an
information message is displayed.

37

Verify Part number
against a Microsoft
Excel sheet
(replaces check
no. 13)

Compares the Part number against Part numbers out of a Microsoft
Excel sheet.
This check compares the Part/Item Number of the Component
MDS/Module against many Part/Item Numbers in a column in an Excel
Spreadsheet.
If the MDS/Modules Part/Item Number does not occur in the
Spreadsheet an information message is displayed.
Remark:
For Semicomponent MDS/Modules the Item/Mat. No will be checked
instead, for Material MDS/Module the Internal Mat.-No.
The column in the sheet is specified by a column number, starting with
1. A column header should not be used.

38

MDS is attached to
Request Check

Verifies if the given MDS is attached to a Request.

39

Extended ELV heavy
metals check

Checks if substances of the ELV heavy metals group exceeding a given
threshold are referenced in a material using a given application ID.

Adding Parameters to Checks Requiring Them

For some of the checks you can define the parameters yourself:

Example: Joker & confidential substance check. This special check examines an entire MDS for this limit, i.e. if
the limit for Jokers and confidential substances is reached adding all values from the top node and all
referenced nodes.
The weight of a complete component is 110g. You define a threshold for Jokers and confidential substances of
5%, which leads to 5.5 g of Jokers and confidential substances allowed in the total tree structure. This check
verifies if this threshold is reached: if for example the amount of “Misc.” in the complete MDS is 5.3 g then this
would be 4.81%. In this case, the check is successful and no information message appears. As soon as you
would set the threshold to 4.0 % a message would inform you that your value is exceeded.
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Flagging Checks for Automatic Rejection

If you are using Inbox Automation, you may want to flag certain critical checks for automatic rejection. Good
uses of this feature are checking for valid part numbers, supplier codes and material classifications although
any check could be flagged as such.

Should you use this check in Inbox Automation, the flagged checks will trigger automatic rejection and the
rejection reason will be entered based on the flagged checks that the MDS failed.

IMDS Default Checks

The IMDS checks execute the Standard IMDS checks against an MDS and are also executable in the In Box.
The IMDS checks produce errors and warnings like in the IMDS Online application. All other checks produce
information messages only.

Part Number Check Against Datasource (ODBC)

This check (number 14) allows access to the data of an Inhouse System via JDBC. Databases like Oracle,
MySQL, Microsoft SQLServer, Microsoft Access can be used.
For example a list of internal part numbers in your company exists in a database file on your PC. When you
receive an MDS you want to check if the part number stated in the MDS by your supplier exists in your file.
To configure the check the following parameters have to be filled in:

The JDBC Connection String is:

jdbc:odbc:<DataSourceName>

In our example:

jdbc:odbc:MY_PART_NUMBERS
(i.e. the name of the data base in ODBC)

The JDBC Driver is under Windows:

sun.jdbc.odbc.JdbcOdbcDriver (for our example the same)

The SQL Statement can be:

select * from [<WorkSheet>$] where <ColumnName>
like '<%partNo%>' [<moreSqlStatements>]
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select * from [PARTS$] where PART_NO = '<%partNo%>'

If this check is now chosen for an MDS, it examines if the part number in this MDS corresponds with any part
number in your database file (i.e. if it is a correct part number of your company).

Start the Examiner Function
To use an examiner profile, you need to be viewing the Ingredients of an MDS/Module. From one of the
searches (component, semicomponent, material, In Box, Out Box), highlight a datasheet and click on the
Ingredients tab.
Then you can use either the Optimizer > Examiner menu option or the
profile search” to search for a certain check profile.

button in the toolbar and chose “start

Then the Examiner Profile screen will appear.

Clicking on Apply or Apply & Close will start the check.
Alternatively, one of the latest 10 checks can be carried out. You can chose it from the list of check profiles
when clicking on the check button. There is a video tutorial available on how to use the Examiner Check button
under the menu item Help.

The same menu is available under Optimizer  Examiner

All informational messages and warnings resulting from the check are displayed at the bottom of the screen.
Clicking on a message will take you to the node where the check has failed:

April 2022

IMDS-a2 Version 13.2

Page 71 of 142

User Manual

IMDS-a2

Examiner Report
The Examiner Report allows the user to forward the output of an Examiner check to a PDF report. All check
results are listed in a table structure including the MDS node on which the error, warning or information
occurred. The profile used when executing the check and all checks that belong to that profile including their
parameter settings are also documented.
There is a video tutorial available on how to use Examiner and create an Examiner report under the menu item
Help.
You can generate an Examiner report for a pre-selected MDS/Module. The precondition for the generation of an
Examiner report is a previous execution of an Examiner check for the MDS/Module. If no previous Examiner
check was carried out an error message will be shown.
After you carried out an Examiner check and received Examiner check results press the Print icon and choose
the item "Examiner Report" from the list in MDS Report window.

Exchanging Examiner Profiles
Examiner Profiles can be exchanged with your co-workers within your company or they can be exchanged with
suppliers or recipients in different companies.
Profiles can only be used by IMDS-a2 users.
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Profile Maintenance Search
With Optimizer > Examiner > Start Profile Search or in the Administration > Profile Maintenance menu all
Profiles can be searched. Your own personal Profiles (private), the own Profiles released for your company
(internally released), the own Profiles sent to a different company (sent), the Profiles published for all IMDS-a2
users (published) and the Profiles sent to your company (received).
You have several search criteria available:
Name

The Profile’s name

Description

Describing the purpose of the Profile

Recipient/Sender

The company receiving / sending the Profile

Status

All status fields can be optionally used

private

Your own Profile, can only be seen and changed by owner

internally released

Can be seen and used by all users of the company

sent /received

Can be seen and used by the receiving company

published

Can be seen and used by all IMDS-a2 users

The following information is displayed in the result list:
Nr.

The row number in the result list

Name

The Profile’s name

Description

Describing the purpose of the Profile

Owner Company

The owning company

Owner

Creator of Profile

Status

Private, internally released, sent/received or public
If own profiles are searched, the status Sent is shown;
if received Profiles are searched, the status Received is
shown.

Status Date

The last change date

Functions available
Create

Create a new Profile and edit in the Detail tab folder

Delete

Delete the currently selected Profile.
All own Profiles may be deleted, regardless of their status.

Copy

Creates a copy of the selected profile.

Release Internal

Makes the profile available to all users in your “roof”
company and sets it so no further changes can be made.

Send

Send the current own Profile to all companies added in the
Recipients tab folder.
You may add recipients to already sent Profiles and the
recipient will see the Profile as received

Publish

Publish the current Profile to all IMDS-a2 user

Edit

Edit the current Profile by selecting the Detail tab folder

Profile Maintenance Detail
Private Profiles may be edited here. All other states are read-only.
Owner (owner company and owner) and Status (Status and Status date) are read-only. The editing of the
profiles is explained in the section “Profile Maintenance”.
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Functions available:
Save

Save all changes

Profile Maintenance Recipients
If a profile should be sent to a different company, the companies are to be entered here. Use the Add button to
open a company search window or use an already opened one to drag and drop the company.
It is not possible to send Profiles to the own company or its Org.-Units.

The following information is displayed in the result list:
Nr.

The row number in the result list

Company name

The root company’s name and company ID

Org Unit

The receiving org unit and its company ID

Sent

The date the Profile has been sent.
‘---‘ if not yet sent

Functions available
Add

Open a company search window to select and add a
company

Delete

Delete the currently selected company, regardless of the
status.

Save

Save all changes
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Inbox Automation
By using Inbox Automation, IMDS-a2 can process received MDSs automatically by using the Examiner to
validate them in the background while the user is logged into an a2 session. In a user-defined interval, the a2
can check for newly received MDSs and add them to the MDS List area. Also, open MDSs (not yet browsed and
browsed) already contained in the In Box can be processed. There is an option to either add all open MDSs to
the MDS List area or to add them manually from the In Box by applying search parameters. You must be in an
active IMDS-a2 session to use Inbox Automation.
The Inbox Automation feature uses a single Examiner Profile to review MDSs received by the company. When
the Inbox Automation is started, the system runs the Examiner Profile for each MDS in the MDS list and saves
the result. Between checking MDSs, there is a system defined idle time to save system resources on the client
and the server.
After the entry has been processed through the check, you may select it and perform one of the following
actions from the Inbox Automation window:
1. View the MDS together with the results of the Examiner. The user can check the errors, warnings and
informational messages and decide whether the MDS should be accepted or rejected. If the Examiner did
not run yet on an MDS, it can also be viewed but without the result messages. To view the MDS from the
Inbox Automation window, double click on the MDS and another window will open.
2. Accept the MDS. Only possible after the Examiner has been run from the Inbox Automation Window. The
MDS may still be accepted without the Examiner run from the normal In Box.
3. Reject the MDS. Only possible after Examiner has been run from the Inbox Automation Window. By using
this option, the rejection dialog appears and the results of the examiner are copied into the reject reason.
The user can then modify this text for the recipient. Depending on the recipient, the Examiner result text can
be translated into several languages within the dialog. Like in the rest of the system, Japanese, Korean or
Chinese language is not supported for data entry. Should the user reject from the normal In Box window
and not the Inbox Automation window, the Examiner messages will not be available.
Inbox Automation can be configured to accept MDSs automatically if they do not contain errors. Inbox
Automation can be configured to ignore warnings and/or info messages and still accept.
Inbox Automation can also be configured to automatically reject MDSs if they do not match given criteria which
are set in the Examiner profile. Since the rejection is automatic, the user is not able to add own text to the
rejection message.
The MDS List area in the Inbox Automation Window is a view on the normal In Box with columns added for
errors, warning and info messages. If these columns are empty, the MDS has not yet been examined. After the
MDS has been examined, these columns contain the number of messages for each category. After the MDS
has been processed (accepted or rejected), the MDS is removed from the list.
The background processing of the Inbox Automation can be started or stopped by the user. The results of the
Examiner are stored as long as the a2 session is open. After closing a2, the results are discarded. Any open
MDS can be added during another session and the Inbox Automation can then recreate the results.
After creating the desired Examiner Profile, the Inbox Automation can be accessed from the Optimizer menu:
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After selection of Inbox Automation from the menu, a new window opens:

Clicking on the icon

opens a demonstration video on how to use this IMDS-a2 feature.

The window is divided into the control section and a worklist section with action buttons at the bottom of the
window. The control section consists of 4 parts.
1. In the status section, the Inbox Automation can be started and stopped, and the action currently being
performed is shown next to the word Status. Actions can be an Examiner running against a specific MDS
as shown below, checking for received MDSs, or “idle” when in the system defined idle time as described
above.

2. In the worklist section, the check for received MDSs can be activated, and the corresponding check interval
in minutes can be selected. This interval is how frequently a2 will go to the IMDS server and check for
MDSs received while the user has been in the a2 Inbox Automation session. The Examiner check runs only
after Inbox Automation is started.
A click on the “Add open MDSs” button starts a search for all open MDS (not yet browsed and browsed)
from the In Box. The result is added to the MDS List area. The “Selection of MDS” button allows the user to
select specific MDSs from the In Box search screen to add to the MDS List (described below).

3. In the profile section, a previously defined Examiner profile needs to be selected. This profile will be used to
review the MDSs in the MDS List.

4. In the action section, the user can select whether the MDSs should be automatically accepted after the
Examiner run if there are no errors. In case of errors, the MDS will not be accepted. The user can decide if
warnings and/or info messages should be ignored by the automatic accept. If the user marks “ignore
warnings” the MDS will be accepted or rejected automativally even if the check result includes warning
messages. After automatic accept, the MDS will be removed from the MDS List. The MDSs can also be
automatically rejected according to the criteria set in an Examiner profile.
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In the MDS list area, the “Selection of MDS” button opens the In Box search screen in a slightly modified
manner. The status field of the search criteria is pre-selected with not yet browsed and browsed. These are the
only states which can be added to the Inbox Automation. All search criteria can be used in the same manner as
for the In Box. From the search results, a single MDSs can be moved from the In Box to the Inbox Automation
list with Drag & Drop. Alternatively, all MDSs with the correct state can be added by clicking the apply button. If
MDSs with states other than not yet seen or browsed are in the list, they will not be added to the Inbox
Automation and a message will inform the user about this. The following picture shows the modified In Box
search screen:

The MDS List area in the Inbox Automation contains the MDSs from the In Box that should be processed. After
MDSs have been added and the Inbox Automation is started, each entry will be processed by the Examiner and
the count of messages of each type will be displayed in the MDS list.
Should you want to change the list of MDSs to examine, it is possible to remove either a single entry or all
entries from the list. This feature is available from a popup menu accessed by clicking with the right mouse
button in the MDS List area. The following picture shows the MDS List with its buttons and the popup menu:

At the bottom of the window, there are three buttons. The view button is active when an entry in the Out Box is
selected. After clicking the view button, the normal MDS detail window is opened. The normal MDS detail
window can also be accessed by double clicking on the item in the list. If the result of the Examiner is present
for the MDS, then the messages will be shown within the MDS window. The accept button is active after the
Examiner run and there were no error messages. The reject button is always active after the Examiner run.
After clicking the Reject button, the MDS rejection page opens and the reject reason is filled with the messages
from the Examiner. There is an option to translate the text into another language (except Japanese, Korean or
Chinese). The following screen shows the rejection dialog with the additional features: Only the Examiner error
messages can be translated. Any text that you enter cannot be translated.
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Dashboard
The IMDS-a2 Dashboard function is actually two Dashboards. One Dashboard tracks MDSs and the other
tracks Requests. Each Dashboard shows the numbers of each in the different “states” and, where appropriate,
flags indicating the criticality of items needing attention based on dates (red-yellow-green). The system uses
Red for ‘due today’ , Yellow for ‘due in x days’ and Green for ‘due in more than x days’.
For MDS Requests, the Deadline Date is used to sort requests into the date ranges. E.g. a Request with a
deadline date greater than today will be within the red range. For MDSs, there is no deadline date within IMDS,
so an internal Tolerance in days can be set (Administration – Options) for sent and received MDSs.
The Dashboard views can be configured by selecting suppliers, recipients and own organizational units.
The Dashboard is called by pressing the Dashboard icon

Clicking on the icon

or in menu item Optimizer > Dashboard:

opens a demonstration video on how to use this IMDS-a2 feature.

Depending on the amount of data associated with your company, the Dashboard may take a few minutes to
load. However you can work in other windows while waiting for the Dashboard to load.
Whenever you see a “state light”, you can see how the items break down into the related states by percentage
by mousing over the desired state and the percentage appears as a tool tip as shown in the following example:

MDS Dashboard
The MDS Dashboard shows all MDS that are visible to your user ID and their current recipient state. Some
states are additionally divided into due date ranges red, yellow and green. You may set the range dates yourself
by using the Administration > Options menu and setting the ‘yellow limit’.
Red
Yellow
Green

means due today
means due between today and ‘yellow limit’ days
means due later than ‘yellow limit’ days

Since technically, an MDS has no due date, a2 uses an virtual due date, that can be also set in the
Administration > Options. This ‘MDS tolerance’ is the number of days that are added to the last state change.
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The following window shows an example of the MDS Dashboard view.

Example:
The ‘yellow limit’ is set to 10 days in the Administration > Options menu. Today is May, 1st.
So, the due date ranges are today:
red
May, 1st

≤

May, 2nd

yellow
May 11th

>

green
May, 11th

An MDS is received on May, 1st and has the recipient state ‘Not Seen’. The ‘MDS tolerance’ is set to 15 days.
So, the virtual due date of this MDS is may, 1st + 15 days: May 16th.
The due date matrix will look as follows:
On May, 1st ,
status red are all MDSs with due date May, 1st and older
status yellow are all MDSs with due dates May, 2nd to May, 11th
status green are all MDSs with due dates May 12th and more
On May, 2nd,
status red are all MDSs with due date May, 2nd and older
status yellow are all MDSs with due dates May, 3rd to May, 12th
status green are all MDSs with due dates May 13th and more
and so on…

1st
2nd
3rd
4th
5th
6th
7th
8th
9th
10th
11th
12th
13th
14th
15th
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So, our example MDS is:
On May, 1st until May, 4th the MDS in status green.
On May, 5th until May, 14th, the MDS in status yellow.
When May, 15th is reached, the MDS will get status red.

Received MDSs

The Received MDSs area of the Dashboard shows all MDSs sent to your company that are visible to your ID
(see previous discussions on Org Units). The recipient states not yet browsed, browsed and rejected are
separated in due dates and presented in red-yellow-green status areas. Additionally, number of MDSs in the
recipient states accepted, modified, cancelled by sender and in process at recipient are presented.
Should you click on one of the boxes, a search is performed with the result being all MDSs that fall into the
category of the box clicked.

Own MDSs

The Own MDS area of the Dashboard shows high level statistics for MDSs created by your company – those
still in Edit mode, the number internally released and the number Published.
Should you click on one of the boxes, a search is performed with the result being all MDSs that fall into the
category of the box clicked.

Sent MDSs

Shows all MDSs sent from your company. Most of the statistics (not yet browsed, browsed, accepted,
modified, cancelled by sender and in process at recipient) are presented in a summary format with only the
total count presented. MDSs that have been rejected do require correction so these items are presented in redyellow-green format based on the Tolerance value that has been set up in Administration > Options >
Dashboard.
Should you click on one of the boxes, a search is performed with the result being all MDSs that fall into the
category of the box clicked.
You may configure the Dashboard view by selecting from the dropdown parameters Own Org.Unit, Supplier or
Recipient. The supplier dropdown is populated with all suppliers that sent at least one MDS to your company.
The recipient dropdown field is populated with all recipients to which your company sent at least one MDS. After
changing one of the parameters, the data is refreshed automatically. However, should you have the Dashboard
open during your entire session and want to refresh the data, you can click on the Refresh button.

MDS-Request Dashboard
The MDS Request Dashboard shows all own and received MDS and their current state.
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Some states are separated into due date ranges: red, yellow and green. You may set the range dates yourself
by using the Administration > Options menu and setting the ‘yellow limit’.
Red

means due today

Yellow

means due between today and ‘yellow limit’ days

Green

means due later than ‘yellow limit’ days

Own Requests

Shows all own Requests. The states new, sent and working are split in due dates.
The recipient states awaiting acceptance, completed, rejected and deleted are presented as totals.
Should you click on one of the boxes, a search is performed with the result being all Requests that fall into the
category of the box clicked.

Received Requests

Shows all received Requests. The states received and working are split in due dates.
The recipient states awaiting acceptance, completed, rejected and deleted are presented as totals
Should you click on one of the boxes, a search is performed with the result being all Requests that fall into the
category of the box clicked.
You may configure the Dashboard view by selecting one of the parameters Own Org.Unit, MDS Supplier or
MDS Recipient. The MDS Suppliers dropdown field is populated with all suppliers that received at least one
MDS Request from you.
The MDS Recipient dropdown field is populated with all recipients, that sent at least one MDS Request to you.
After selecting from the dropdown menus, the data is refreshed automatically. You may leave the Dashboard
open during your entire a2 session. Should you want to refresh the view at any time during your session, simply
click on the Refresh button.
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Reports
There are several types of reports that can be generated in IMDS-a2. These reports are only available in .pdf
format at this time. The security settings only allow printing the .pdf file.

MDS Report
It is possible to print a pdf MDS report (either a “Header Only Report” or a “Full Report”) for all MDSs visible to
your company (own MDSs, received MDSs and published MDSs).
The MDS Report can be printed when you are in the Ingredients screen for an MDS by using the printer symbol
or the menu item Optimizer > Reports.

The following window appears in which the option can be chosen from which point of view the Report will be
printed. For Received or Published, only your company’s view is allowed. From an MDS that has been sent, you
can select either the view of your company or the view of your recipient. This is important if the part/item
number or description on your ingredients page is not the same as those fields on the recipient data page.

After the choice and clicking “OK” the pdf is created and can now be printed and/or saved:
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Special IMDS-a2 Reports
There are several reports that are available in IMDS-a2 that are not available in the IMDS browser. This section
details both existing and planned reports.

Overview of Special IMDS-a2 Reports

The table below shows all reports that will be generated in the IMDS-a2; the column ID gives a unique reference
to be used through the complete documentation of the IMDS-a2 Reporting.
ID

Report name

Report type

Short description

1

MDS Report – Header
Only Report

Single Item Report

Only the Header Page (1. Company and Product
Name) of the MDS Report will be generated.

2

MDS Report – Full
Report

Single Item Report

Initial Sample Report:
• List the tree structure with all contained nodes

3

Detailed Analysis

Single Item Report

Detailed Analysis Report:
• Summaries for materials, material
classification and substances of a MDS with
related masses/
portions for each contained value of each
aspect

4

Invalid Nodes

Single Item Report

Unmatched Nodes Report:
• all Non-Substance Nodes with no child node
• nodes linked to a deleted or not yet released
MDS

5

Structure Validation

Single Item Report

Structure Validation Report:
• substances with Non-Material parent node
• deleted nodes (incl. MDS deleted)

6

Referenced MDSs

Single Item Report

List supplier for each Referenced MDS

7

Sent MDS Statistics

Summary Report (in
the Out Box)

List of all MDSs per client, per date and status

8

Sent MDSs Incomplete

Summary Report (in
the Out Box)

Which sent MDSs are still outstanding? (IMDS
status = not yet browsed, browsed, in process at
recipient)

9

Suppliers With
Oversized Ranges

Summary Report (in
the Analysis)

Which suppliers have datasheets with oversized
‘from-to’ ranges?
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ID

Report name

Report type

Short description

10

Enhanced MDS
Statistics

Summary Report
(in the Out Box)

To which clients did my company (also possible:
Org Units, sender, contact person) send which
MDSs?

11

Deleted Substances

Summary Report (in
the Analysis)

Which MDSs contain deleted/hidden basic
substances/MDSs?

12

Applications and Parts
Marking

Single Item Report

Applications and Parts Marking Report:
• node with application relevant information
• node with parts marking information

13

Declarable Substances

Single Item Report

Substance Usage Report:
• substances is forbidden
• substance is required to declare

14

Materials according to
RRR Categories and
IMDS categories

Single Item Report

Report with the calculation of Material content
according to:
• ISO22628 (RRR)- and
• IMDS-categories

Layout of IMDS-a2 Single Item Reports

All single item reports have the same layout, see following figure:
Header

Report Title
Company- and Product Description

Product
Description

Supplier
Description

Recyclate Information

Report Detail Table

Footer

All sections of the single item reports, exclusive the report detail table, have the same general layout regardless of what single item report is being generated. In following sections, the layout of the report is
described while the specific contents of the “report detail table” is described in the section titled with each report
type.
The Header contains the following information:
Attribute

Remark

IMDS ID / Version

Module ID and Version of the selected MDS

User

Name associated with the ID that generates the report

Page

Actual page number of total pages

Date

Report generation date
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The Report title contains the following information:
Attribute

Remark

Report title

Title of the report

Subtitle

Report subtitle, used to give more info about the generated report

The Supplier description contains the following information:
Attribute

Remark

Name [ID]

Name and IMDS Company ID of the MDS supplier company

DUNS number

DUNS number of the supplier company

Street/P.O.Box

Address of the supplier company

Nat.-Des./Zip/City
− Organization unit [ID]

Country code, Zip and city of the supplier company
Organization unit name and IMDS ID of the supplier company

− DUNS Number

Supplying Organization unit ‘s DUNS number

− Street/P.O.Box

Supplying Organization unit’s address

− Nat.-Des./Zip/City

Supplying Organization unit’s country code, zip and city

Supplier Code

Supplier Code information from recipient data screen

Contact person

Name of supplier contact person associated with the MDS

− Telephone

Telephone number of the contact person

− Fax number

Fax number of the contact person

− E-Mail address

E-Mail address of the contact person

The Product description contains the following information from the Recipient data screen:
Attribute

Remark

Part-/Item-Nr

Part-/Item number of the selected MDS’s top node

Article Name

Part-/Item name of the selected MDS’s top node

Report No.

Sample report number

Date of Report

Sample report’s generation date

Purchase Order No.

Purchase order number

Bill of Delivery No.

Bill of delivery number of

Preliminary MDS

Whether or not this is a Preliminary MDS

IMDS ID / Version

IMDS module ID and Version of the selected MDS’s top node

MDS Status
(Change Date)

Current state of the selected MDS and date of last status change

Recipient Company
(Org Unit) [ID]

Name and IMDS company ID of Recipient Company (Org Unit)

Recipient Status
(Change Date)

Status of the MDS at the recipient and status change date.

Accepted by/
Rejected by

Name associated with the ID that accepted/rejected the MDS.
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The Recyclate information contains only following static text:
Text output
Since IMDS Release 3.0 recyclate information is attached to references on certain materials.
Substances that are legally prohibited must not be referenced! Hazardous substances that will be
created by or emanate during usage must be declared. Reference: VDA list of declarable substances
(see GADSL)
The Footer contains following for all reports other than the MDS Report which has the same footer as in the
IMDS browser:
Position

Text output

Left

EntServ Deutschland GmbH

Center

Created by IMDS-a2 Optimizer

Right

DXC company logo

MDS Report
Use

This report decomposes a single MDS related node into the complete tree structure together with certain node
and relation attributes. This report is exactly the same as the Preview report in the IMDS Web version.

Report Detail

The Report Detail Contains a Header and a table containing the details.
The Report Header contains the following information:
Attribute

Remark

Part/Item Number

The Identifying Part/Item Number

Part Name

The Identifying Name

Report No.

Number of this a2 Report

IMDS ModuleID/Version

IMDS ID, version and Node ID

The report detail provides one line per MDS tree structure node including the usage of this node. It contains the
following attributes:
Attribute

Node Type

Level

Component /
Semicomponent /
Material /
Substance

Column 1
Tree level in the MDS tree structure

Part Name

Component /
Semicomponent /
Material /
Substance

Column 2
Indicates Component / Semicomponent / Material node type:
appropriate Component-, Semicomponent- or material name,
In case substance node: the substance synonym

Part/Item
Number

Component /
Semicomponent /
Material /

Column 3
In case Component / Semicomponent / Material node type:
the appropriate Component-, Semicomponent- or material
number
In case substance node: the CAS number

Substance
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Attribute

Node Type

Remark

IMDS ModuleID
+ IMDS Version

Component /
Semicomponent /
Material

Column 4
The IMDS ID and version if visible to the company

Quantity

Component

Column 5
Quantity of component in the assembly

Weight [g]

Component /
Semicomponent /
Material

Column 6
absolute mass value for a certain node, applicable only for
Component, Semicomponent or material

Portion [%]

Semicomponent /
Material /
Substance

Column 7
absolute portion value for a certain node, applicable only for
Semicomponent, material or substance

Portion Interval
(from – to) [%]

Semicomponent /
Material /
Substance

Column 8
allowed min and max portion value for a certain node,
applicable only for Semicomponent, material or substance

Classification

Material

GADSL

Substance

Column 9
in case material node the material classification (name /
code)
in case substance node the GADSL info

Polymer name

Component

Recyclate
Application

Material
Substance

Column 10
In case component node: the polymer name of the
component
In case material node: the recyclate info
In case substance node: the application info

Detailed Analysis
Use

This report is the equivalent of running all 6 Analyze options in IMDS Browser.

Report Detail

Report details include three sub tables. It contains the following information:
• Material Classifications:
Attribute

Node Type

Remark
EN_US: Analysis Material Classifications
DE_DE: Klassifikation Analyse

Title of sub table
Classification
Number

Material

Column 1
Contains the material classification number

Classification
Name

Material

Column 2
Contains the classification name

Weight [g]

Column 3
absolute mass value

Portion [%]

Column 4
absolute portion value
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• Materials:
Attribute

Node Type

Remark
EN_US: Analysis Material
DE_DE: Material Analyse

Title of sub table
Material ID /
Version

Material

Column 1
The IMDS ID and version of the material

Classification
No.

Material

Column 2
The material classification number

Classification
Name

Material

Column 3
The material classification name

Name

Material

Column 4
The name of the material given by the MDS supplier

Weight [g]

Column 5
absolute mass value

Portion [%]

Column 6
absolute portion value

• Basic Substances:
Attribute

NodeType

Remark
EN_US: Analysis Basic Substance
DE_DE: Reinstoff Analyse

Title of sub table
Node ID

Substance

Column 1
IMDS Substance Node ID

CAS No.

Substance

Column 2
CAS number

Synonym

Substance

Column 3
Substance synonym

Weight [g]

Column 4
absolute mass value

Portion [%]

Column 5
absolute portion value

Invalid Nodes
Use

The user wants to identify nodes from the tree for which at least one of the following conditions is fulfilled:
• The node does not represent a basic substance but is not decomposed any further (i.e. has no child nodes)
• The node is Top node of a MDS which is not yet released
• The node or its related MDS is deleted
The report provides the user with complete tree structure paths together with nodes that fulfill at least one of the
above conditions.

April 2022

IMDS-a2 Version 13.2

Page 89 of 142

User Manual

IMDS-a2

Report Detail

The Report detail contains the following information:
Attribute

Node Type

Remark

Level

Component /
Semicomponent /
Material

Column 1
Tree level in the MDS tree structure

Article Name

Component /
Semicomponent /
Material

Column 2
appropriate Component-, Semicomponent- or material name

Part/Item
Number

Component /
Semicomponent /
Material

Column 3
the appropriate Component-, Semicomponent- or material
number

IMDS
ID/Version

Component /
Semicomponent /
Material

Column 4
The ID and version number if visible

Node ID

Component /
Semicomponent /
Material

Column 5
IMDS node ID – applicable only for components

Report Content

Not all nodes of the tree structure are represented in this report. The Invalid Nodes Report shows nodes that
• represent either a Component or a Semicomponent or a Material
• are in the tree of the selected MDS
• are not parent to some sub node (meaning final decomposition down to substances is not defined)
OR
− are top node of a MDS which is not yet released
OR
− are deleted or its related MDS (if existent) are deleted
Along with the level, column 1 may also contain a flag indicating a problem with the node. The following table
contains the meaning of images used in report:
Image

Meaning
The node or its related MDS is deleted
The node is a parent of a MDS which is not yet released
The node has no child nodes

Structure Validation
Use

The user wants to identify nodes within the tree for which at least one of the following conditions is fulfilled:
• The node does not represent a Material but is directly decomposed to at least one substance (i.e. wrong
parent node type for substance)
• The node or its related MDS (if existent) is deleted
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Report Detail

The report detail contains the following information:
Attribute

Node Type

Level

Component /
Semicomponent /
Material /
Substance

Column 1
Level in the MDS tree structure

Part Name

Component /
Semicomponent /
Material /
Substance

Column 2
In case Component / Semicomponent / Material node type:
appropriate Component-, Semicomponent- or material name,
In case substance node: the substance synonym

Part/Item
Number

Component /
Semicomponent /
Material /

Column 3
In case Component / Semicomponent / Material node type:
the appropriate Component-, Semicomponent- or material
number
In case substance node: the CAS number

Substance

Remark

IMDS
ID/Version

Component /
Semicomponent /
Material

Column 4
The IMDS ID and version number if visible

Node ID

Component /
Semicomponent /
Material /
Substance

Column 5
IMDS node id

Quantity

Component

Column 6
Quantity of component used in assembly

Weight[g]

Component /
Semicomponent /
Material

Column 7
absolute mass value for node, applicable only for
Component, Semicomponent or material

Portion [%]

Semicomponent /
Material /
Substance

Column 8
absolute portion value for node, applicable only for
Semicomponent, material or substance

Portion
(from – to) [%]

Semicomponent /
Material /
Substance

Column 9
allowed min and max portion value for node, applicable only
for Semicomponent, material or substance

Classification

Material

GADSL

Substance

Column 10
in case material node, the material classification (name /
code)
in case substance node, the GADSL info

Parts Marking

Component

Recyclate
Application

Material
Substance

Column 11
In case component node: whether the Parts Marking
question has been answered
In case material node: the recyclate info
In case substance node: the application info

Report Content

The Structure Validation Report shows a BOM view of invalid paths, i.e. paths starting with the top node and
going down to some invalid node as path end point.
A node that fulfills at least one of the criteria below is considered an invalid node and a path end point:
• The node does not represent a Material but is directly decomposed of at least one substance (i.e. wrong
parent node type for substance), i.e. the node represents either a Component or a Semicomponent with a
substance as direct child.
• The node or its related MDS (if existent) is ”deleted”.
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Along with the level, column 1 may also contain a flag indicating a problem with the node. The following table
contains the meaning of images used in report:
Image

Meaning
The node or its related MDS is deleted
The node is wrong parent node type for substance
The node is wrong parent node type for substance and is deleted

Referenced MDSs
Use

The user wants to identify Components, Semicomponents or Materials contained in the tree in order to inspect
the related supplier information.

Report Detail

The report detail contains the following information:
Attribute

Node Type

Remark

Part Name

Component /
Semicomponent /
Material

Column 1
appropriate Component-, Semicomponent- or material name

Part/Item
Number

Component /
Semicomponent /
Material

Column 2
the appropriate Component-, Semicomponent- or material
number

IMDS ID/
Version

Component /
Semicomponent /
Material

Column 3
The IMDS ID/Version if visible

NodeID

Component /
Semicomponent /
Material

Column 4
IMDS node ID

MDS Status

Component /
Semicomponent /
Material

Column 5
MDS Status

MDS Company
(Name/ID)

Component /
Semicomponent /
Material

Column 6
company info of MDS’s creating company
(Company Name / ID)

MDS Org Unit
(Name/ID)

Component /
Semicomponent /
Material

Column 7
organization unit info MDS is assigned to in the creating
company (Organization Name / ID)

Sent MDS Statistics
Use

The user wants to get an overview of all MDSs sent to customers. Three different views are available:
• MDSs sorted by receiving company, sending date
• MDSs sorted by sending date
• MDSs sorted by status, receiving company, sending date

Report Detail

The report can be directly created from the Out Box. The amount of result rows is limited to 12,000 rows which
corresponds to approx. 1,000 pages.
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Sent MDSs Incomplete
Use

The user wants to get an overview of all MDSs sent to customers which have not yet been accepted or rejected.
Three different views are available:
• MDSs sorted by receiving company, sending date
• MDSs sorted by sending date
• MDSs sorted by status, receiving company, sending date

Report Detail

The report can be directly created from the Out Box.
The amount of result rows is limited to 12,000 rows which corresponds to approx. 1,000 pages.

Suppliers With Oversized Ranges
Use

The user wants to get an overview of all received MDSs that contain invalid range data according to
Recommendation 001 for at least one sub node along with related supplier information.

Report Detail

The report is part of the IMDS-a2 Analysis module. There the user can search for certain thresholds - the results
are shown in the result table and can be printed there.

Enhanced MDS Statistics
Use

The user wants to get an extended overview of all MDSs sent to customers. Three different views are available:
• MDSs sorted by receiving company, receiving organization unit, sending date
• MDSs sorted by sending date
• MDSs sorted by contact person associated with the MDS (last name, first name), receiving company,
receiving organization unit, sending date

Report Detail

The report can be directly created from the Out Box.
The amount of result rows is limited to 12,000 rows which corresponds to approx. 1,000 pages.

Deleted Substances
Use

The user wants to identify MDSs containing deleted substances/MDSs. Two different scenarios are supported:
• All MDSs sent to the user’s company
• All MDSs created by the user’s company

Report Detail

The report is part of the IMDS-a2 Analysis module. There the user can search for MDSs containing
deleted/hidden substances/MDSs - the results are shown in the result table and can be printed there.
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Applications and Parts Marking
Use

The user wants to identify applications and parts marking for all affected nodes.

Report Detail

The report detail contains the following information:
Attribute

Node Type

Remark

Level

Component /
Semicomponent /
Material /
Substance

Column 1
Level in the MDS tree structure

Article Name

Component /
Semicomponent /
Material /
Substance

Column 2
In case Component / Semicomponent / Material node type:
appropriate Component-, Semicomponent- or material name,
In case substance node: the substance synonym

Part/Item
Number

Component /
Semicomponent /
Material /
Substance

Column 3
In case Component / Semicomponent / Material node: the
appropriate Component-, Semicomponent- or material
number
In case substance node: the CAS number

IMDS ID /
Version

Component /
Semicomponent /
Material

Column 4
IMDS ID/Version if visible

IMDS Node ID

Component /
Semicomponent /
Material /
Substance

Column 5
IMDS node ID

Quantity

Component

Column 6
Quantity of component used in the assembly

Weight [g]

Component /
Semicomponent /
Material

Column 7
absolute mass value for the node, applicable only for
Component, Semicomponent or material

Portion [%]

Semicomponent /
Material /
Substance

Column 8
absolute portion value for the node, applicable only for
Semicomponent, material or substance

Parts Marking

Component

Application
(Name/ID)

Substance

Column 9
In case component node: the answer to the parts marking
question
In case substance node: the application info (Name / ID)

Declarable Substances
Use

The user wants to identify substance nodes within the tree structure for which at least one of the following
conditions is fulfilled:
• The substance is forbidden
• Declaration of the substance is required
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Report Detail

The report detail table contains the following information:
Attribute

Node Type

Remark

Level

Component /
Semicomponent /
Material /
Substance

Column 1
Level in the MDS tree structure

Article Name

Component /
Semicomponent /
Material /
Substance

Column 2
In case Component / Semicomponent / Material node type:
appropriate Component-, Semicomponent- or material name,
In case substance node: the substance synonym

Part/Item
Number

Component /
Semicomponent /
Material /
Substance

Column 3
In case Component / Semicomponent / Material node: the
appropriate Component-, Semicomponent- or material
number
In case substance node: the CAS number

IMDS ID /
Version

Component /
Semicomponent /
Material

Column 4
The IMDS ID and version if visible

Node ID

Component /
Semicomponent /
Material /
Substance

Column 5
IMDS node ID

Company

Component /
Semicomponent

Classification

Material

Application

Substance

Column 6
In case Component or Semicomponent node: its MDS’s
creator company (Name / ID)
In case material node: material classification info
(name / code)
In case substance node: application info (name / ID)

Portion [%]

Substance

Column 7
absolute portion value for a certain node, apply only for
substance

Report Content

The Declarable Substances Report shows nodes that
• represent either a Component or a Semicomponent or a Material that contains Declarable and/or Prohibited
substances that are children
• represent substances that are prohibited or declarable
Along with the level, column 1 may also contain a flag indicating additional information on the node. The
following table contains the meaning of images used in report:
Image

Meaning
Declaration of the substance is required
The substance is forbidden
The substance is forbidden and is required to declare
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Materials according to RRR Categories and IMDS Categories
Use

The user wants to identify the weight in the different material classifications of the materials contained:
• according to the categories ISO 22628
• according to IMDS material classification

Report Detail

The report detail tables contain the following information:
a) RRR Categories Report Table
Attribute

Node Type

ISO 22628
Classification

Material

Column 1
Material classification according to ISO 22628

Weight (g)

Material

Column 2
Overall weight of all materials with this classification

Portion (%)

Remark

Column 3
Portion of all materials with this classification contained

Material name

Material

Column 4
appropriate material name

Weight (g)

Material

Column 5
Weight of the single materials with this classification

b) IMDS Categories Report Table
Attribute

Node Type

No.

Material

Column 1
Material classification number according to IMDS

IMDS
Classification

Material

Column 2
Material classification name according to IMDS

Weight (g)

Material

Column 3
Overall weight of all materials with this classification

Portion (%)

Remark

Column 4
Portion of all materials with this classification contained

Material name

Material

Column 5
appropriate material name

Weight (g)

Material

Column 6
Weight of the single materials with this classification

Report Content

The Materials according to RRR Categories and IMDS Categories Report shows the material classifications
• according to ISO22628 and IMDS
• and the weight as well as the percentages of the materials contained within the different classifications
This means that simple or complex structures can easily be analyzed for material classifications according to
ISO 22628 as well as to IMDS material classifications in order to classify and optimize the use of material input.
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Compare MDSs/Modules
The Compare MDSs/Modules function allows the comparison of two Datasheets or Modules. It displays all
differences in the Ingredients tree, the Supplier Data and the Recipient Data as well as statistical differences
like different amounts of GADSL substances or the overall tree size.
To start the MDS/Module comparison, press the
menu:

Clicking on the icon

button in the icon bar or in the menu or use the Optimizer

opens a demonstration video on how to use this IMDS-a2 feature.

Comparison Icons
There are three icons, you will encounter throughout the whole comparison:
Indicates a difference.
E.g. if this icon is shown next to a weight, the weight is different in both compared MDSs.
Indicates an added entry.
E.g. if this icon is shown next to a node in the Ingredients tree, this node is only available in this
tree and does not exist in the other one.
Indicates a removed / not existing entry.
E.g. if this icon is shown next to a node in the Ingredients tree, this node is not available in this
tree, but in the other one. For information, why not existing nodes are shown, please refer to
“Ingredients Tree Comparison” below.

MDS Selection
The Compare MDSs/Modules window looks as follows:
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At the top of the window, there are two lookup fields. To choose, which MDSs or Modules you want to be
compared, either drop them on the fields or press the
Button to open the MDS/Module search, where you
can press the “Apply” or the “Apply & Close” button after selecting an entry from the search result.
As soon as there are two MDSs/Modules selected, the “Compare” button is becomes enabled. Press it to start
the comparison.

Statistics and Overview
After starting the comparison, all fields are automatically filled in:

As shown in the screenshot, all measured values, which are not equal in both MDSs/Modules are marked with
the difference icon ( ).
Also the tabs “Compare MDSs/Modules”, “Ingredients”, “Supplier data” and “Recipient data” are marked, if
differences have been found in the values visible in this screen. Tabs and values which are not marked do not
show different values.
The compared values in this screen are:
Total node count

The total amount of nodes and referenced MDSs/Modules in the tree.
Basic substances are not counted.

Own nodes and
MDSs/Modules

The amount of own nodes and referenced own MDSs/Modules in the
tree. Own published MDSs are also counted.

Accepted MDSs

The amount of referenced accepted MDSs in the tree.

Publishes MDSs

The amount of referenced published MDSs in the tree. MDSs
published by your own company are not counted.

Maximum tree depth

The highest depth in the tree. If a MDS only contains children with no
children on their own, the depth is 1. Each level of children of children
increases the depth by one. Basic substances are not counted.

Own nodes and
MDSs/Modules

The highest depth in the tree excluding referenced accepted or
published MDSs or Basic Substances.

Total Basic Substance
count

The total amount of Basic Substances in the tree.

Basic Substance lists

This list shows the amount of Basic Substances that are part of a
certain Basic Substance List. The lists available here are the same
that can be selected for highlighting in the Ingredients tree.
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Ingredients Tree Comparison
Important differences to ordinary “Ingredients” screen

The ingredients tab looks different comparing MDSs or Modules:

Both compared MDSs/Modules are shown in a separate tree. When selecting a node in one tree, the
corresponding one in the other tree is automatically selected, too. The same applies to expanding and
collapsing nodes. When scrolling, both trees scroll simultaneously.
There is no context menu available in these trees and functions like “add reference” or “delete” are also
deactivated. Overall, editing is not possible during comparison.
The coloring in these trees also differs from the usual behavior. All nodes – even those beneath referenced
ones – are shown in black or red instead of being gray (which normally indicates that they cannot be modified).
When comparing, gray color is reserved for not existing nodes.
If a tree contains a node, which does not exist in the compared tree, the Compare MDSs/Modules screen shows
this in different ways. First, the existing node in the first tree is marked with a
icon, while an equivalent node
marked as “not existing” ( ) is shown in the compared tree. Additionally this not existing one is displayed in
gray color, stroked and with gray icons. This way, the synchronous scrolling, selecting and expanding/collapsing
in both trees is ensured.

Viewing comparison results in “Ingredients” screen

Differences in the trees can be easily found by following the yellow
icons. If two opposite nodes are marked
with this icon, at least one difference has been found within this node.
If there are changes in the Details, the Recyclate or the Application tab, these tabs are marked. Within open
tabs, all changed fields also show this icon.
If there are no changes in these tabs, but the node is marked as “changed”, one of the node’s children has been
modified. Find a child with the
icon. If this child also doesn’t show any differences in the three tabs, you need
to go deeper into the tree and have a look at the child’s children, and so on.
If you have found a data field marked as “changed”, you can view the different values in both trees by switching
to the opposite node. This can be done by either selecting the opposite node in the other tree, or by using the
two buttons in the top right corner to select for which tree you want to view the details. The buttons show the
name, ID and version of the tree’s top node.
When switching to a not existing node, the right part of the screen will stay empty.
If the Details tab of a node contains a list (e.g. the list of Norms for Materials), these lists may contain entries
with the / icons. Entries marked with the
icon are also displayed in gray (like in the tree). They are
entries, which do only exist in the list within the opposite node. Entries marked with
are entries that do not
exist in the other node.
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Supplier Data Comparison
When comparing two Modules, the Supplier Data screen cannot be selected. If at least one of the compared
entities is a Datasheet, you will see the following screen:

The supplier data screen is split into two halves, one for each MDS. At the top of each half you can see the
MDS’s name and ID/version, while beneath you can see the standard supplier data. Again, you can see the
icon on each field which shows different values in both MDSs.
Note that a difference in one field might cause a difference in others. E.g. a different Contact person is likely to
result in different contact details like phone number or email address.

Recipient Data Comparison
Like the Supplier Data screen, the Recipient Data screen is split into two halves, but cannot be selected, if
comparing two Modules. Again, at the top of each half there is the name and ID/version of the compared MDSs.
When selecting a recipient from the recipient list, it is also selected in the opposite table, if it exists there. If there
is a change in the recipients detail data, the first column of the table shows the
icon.
If one MDS contains a recipient, which is not included in the other MDS’s recipient list, a
icon is shown in the
first column. Note that no gray entries with a
icon are shown in the Recipient Data screen. When selecting a
-marked entry, all rows in the opposite table become deselected:

By pressing the “View” button or by double clicking on a row, you can open the details screen. This screen is
also split into two parts:
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A
icon appears in front of all fields, which show different data in both MDSs. When viewing the data for a
recipient, which is only available in one MDS, the other side of this screen will stay empty.
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Company-specific Basic Substance Lists
Company-specific Basic Substance Lists can be used by every IMDS-a2 user of your company. The Company
Administrator is responsible to create and maintain such lists.
As a Company Administrator please use the respective Optimizer menu to create, maintain or delete a
Company-specific Basic Substance List:

If you have already created company-specific lists, they will be displayed right after launch in the upper area of
the opened window, while the lower part of the window shows the name, description and the contained
substances of the selected Company-specific Basic Substance List:

You can Search for existing lists, Create a new list or Delete an existing list with the corresponding buttons in
the window. The Search can be re-executed. To create a new list, please click on “Create”:
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Now you can enter a Name and a Description in the middle of the window for your new company-specific Basic
Substance List. Substances can be added using drag and drop after pushing the “Add” button in the lower left
corner of the window. Substances can also be added by copying up to 10,000 CAS-numbers. Use the button
"Add multiple Substances", copy the CAS-numbers separated by a space, new line or tab into the pop-up
window and press "Apply".

The CAS-numbers will be resolved and added to the Substance list.
Assigned substances can be removed using the “Remove” button. The “Save” button saves the entered data.
Your company-specific Basic Substance Lists are available for all IMDS-a2 users in your company in the
following functions of the IMDS-a2 application:
• MDS Ingredients tab as Basic Substance List Filter – indicated by the prefix “CS: “
• Basic Substance Search (Groups) – indicated by the prefix “CS: “
• Where-Used Analysis (Basic Substance Lists) – indicated by the prefix “CS: “
• Analysis & Reporting Module – as separate additional analysis criteria
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Analysis & Reporting Module Description
This additional IMDS-a2 module provides unlimited analysis of your IMDS MDSs with revised and refined
analysis capabilities. It needs to be licensed separately from the IMDS-a2.
Using the menu Add-on Modules > Analysis & Reporting opens the analysis window. For users without a valid
license the below message is displayed when opening the window or when trying to launch an Analysis, which
is not allowed without a license:

Users with a valid license can analyze their MDSs with basic criteria, which are displayed as shown below:

The Storyboard area above contains tips for you to know, what to do or what’s done. There are different types
of MDSs, which can be analyzed separately: MDS / Modules, Component, Semi-component, Material and
Outbox. Changing the type of MDSs to be analyzed leads to changes in the "MDS Selection" area – in the
following picture for the type Outbox which allows to analyze MDSs sent to customers.
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You can set additional criteria as already known from other search windows. Clicking the
button, opens a list with all available analysis criteria:

Selecting a criterion and pressing OK adds the corresponding Analysis Criteria panel to the Analysis &
Reporting window.
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or

to move

Every Analysis Criteria panel has different supported parameters, which can be filled/selected for your analysis
(e.g. aggregation type, amount/weights, basic substance, substance group or list, classification). Thresholds
and ranges for percentages and weights can be considered in the analysis, not only the test for existence.
Typical “reference” for percent or weight thresholds are homogeneous material and article for most of the
analysis criteria.
The following Analysis Criteria are available:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Application Code
Basic Substance
Basic Substance Group
Basic Substance List
California Proposition 65
Classification
Company-specific Basic Substance Lists
Confidential Substanes
Conflict Minerals
Deleted and hidden Substances
Deleted, hidden and obsolete MDS/Modules
GADSL / SVHC Category
MDS/Module
REACH Regulations (SVHC, Annex XIV, Annex XVII)
Threshold Range
Contains Recyclate

Multiple analysis can be combined – results can be input for succeeding analysis options. With the Aggregation
Type you can pass MDSs fulfilling the selected criteria to or you can remove those MDSs from the next stage /
result of the analysis.
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A new Substance report is available to export the analysis results. This report however, is only available for
Substance-based reports. In other words, the last analysis criterion must be a substance-related one, e.g.
Substance Group, Substance List, …
Clicking "Substance Report", a dialog allows to define the output format and the file name:

A master/detail report is created first listing the MDS details followed by the Substance details. Only MDSs with
substances fulfilling the search criteria are listed. In the above sample, these are SVHC Substances exceeding
0.1% regarding their contents in the Article. After the first MDS found, the next MDS is listed followed by its
substances.
MDS information listed in the report:
•
•
•
•
•
•
•

No.
MDS Type
Name
Part/Item/Mat.-No.
ID / Version
Node ID
Supplier/Recipient

Substance information listed in the report:
•
•
•
•
•
•
•
•
•

Type
Substance name
CAS No.
GADSL / SVHC
Article Node ID
Article Name
g Article (only for reference "Article")
% Article / % H.-Mat.
Group/List Membership
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The output format "Microsoft Excel" is only available for smaller reports since the number of rows is limited in
the Microsoft Excel application. In these cases, the CSV format should be used instead.

Examples for Analysis Criteria:

Check for MDS/Modules using the given Application Code.

Check for substances underlying the California Proposition 65.

Check for substances using different GADSL / SVHC categories and/or tresholds/ranges.

Check for materials/articles containing REACH relevant substances (REACH SVHC, Annex XIV, Annex XVII).
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SCIP (Substances of Concern In articles as such or in complex
objects (Products))
SCIP AttributesIn order to help companies to fulfil their duties within the EU’s SCIP database, IMDS provides
the possibility to collect data necessary for SCIP.
For Component MDSs you can add the following attributes:
1. SCIP Number and SCIP Submission Number (refer to data uploaded to SCIP).
2. First Submission Date and Last Submission Date are available if the component MDS was submitted.
3. If an MDS is submitted to SCIP a message confirms the submission "This MDS has been submitted to
SCIP by IMDS". Assume SCIP Defaults and Include classification 9.x are available if the component MDS
was submitted.
4. Production in European Union: You can choose from four options either EU Produced, EU Imported, EU
Produced and Imported or No Data which is the default chosen value.
5. SCIP Article Category:
•

The User can assign SCIP Article Categories through the Add button "+", which opens a lookup
for Article Categories. The lookup initially shows default SCIP Article Categories which have been
imported into IMDS, but a search functionality is provided to allow filtering for desired Taric
Code(s).

•

The User can select a single or multiple Article Category/-ies and "Apply" these to the current
component. A popup for notification appears if a pre-assigned Article Category was selected.

•

Selected Article Categories appear in a table in the ingredients section “SCIP”. The User can
remove any of the assigned Article Categories at any time by selecting the respective row in the
Article Category table and clicking the remove "-" button.

•

Saving the Component will also save the Article Category assignment to this component.

•

Creating a new Component MDS, the default Article Category/-ies appear(s) in the Article
Category table.

•

If a new version or a copy of the Component MDS is created or this MDS is forwarded and if this
Component did not have any Article Categories assigned before, the default Article Category/ies is(are) assigned to the Component and added to the Article Category table.

•

For each Article Category assigned to the Component, an icon "?" is provided in the Article
Category table to allow the User to see the full description for the assigned SCIP Article
Categories.

6. SVHC Safe Use Instructions Required: This can be checked in case there are safe use instructions
available for this component.
7. Safe Use Instructions: The User can specify the safe use instructions in this box.
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8. For Material MDSs, SCIP Material Categories can be assigned:
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•

SCIP Material Category is available in the ingredients screen for material types.

•

If a new Material is created, the default SCIP material categories are assigned.

•

The SCIP Material Category List contains all available categories for this material.
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Each row in the list contains [Identifier - Category type - Description Level 1-Description Level
2(if available)-Description Level 3(if available)]

•

Categories can be added or removed in the menu of the list

•

A right click on list displays three possible actions: add, remove categories or reset to default.

•

Changing the chosen classification results in a dialog asking "Do you want to replace the SCIP Material
Category based on the mappings as well ?"
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9. Additional Material Characteristics
- This field is available in the Details page of the material under the SCIP Material Category field and
disabled by default.
- After selecting another material category, this field becomes enabled.

SCIP Bulk Submission
The new Bulk SCIP interface of the IMDS-a2 allows you to submit multiple MDSs per user interaction (a “bulk”
of MDSs) to SCIP. This Bulk SCIP module perfectly harmonizes with the Analysis & Reporting add-on module
of the IMDS-a2 but it can also be used with the Where-Used Analysis, Component search, MDS/Module search
and the Outbox search.
The following screenshot shows the Bulk SCIP Submission functionality in combination with the Analysis &
Reporting module. Simply mark all MDSs previously analyzed and to be submitted to SCIP and launch the
“Submit MDS to SCIP” function using the toolbar icon or the File | Submit MDS to SCIP menu.
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The "Submit MDS to SCIP" dialog is displayed and allows to define the S2S Key to be used for the
submissions.

In this screen the user can choose how to handle classification 9 from the drop-down list "Include SVHC in
classification 9.x (Fuels and auxiliary means)", The drop-down list contains three values: blank (default), yes
and no.
Pressing "…" a list of all defined S2S Keys for the root company and all Org.-Units is shown and the User can
pick one S2S Key.
The User can further define if the IMDS-a2 should assume default values when the MDS or referenced MDSs
do not contain the mandatory SCIP information by checking the field "Assume SCIP defaults". Pressing the
Help button displays an overview on the defaults values assumed by IMDS.
By clicking "OK" the listed MDSs are first validated and then scheduled for submission to SCIP.
Using Search | SCIP Submissions the below window is opened. It lists all submitted MDSs including the
submission state, SCIP Submission No, SCIP No. and other meta data:
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The supported search parameters are the same as in IMDS Web. Additionally, IMDS-a2 allows to search for a
NodeID.
For each of the MDSs a SCIP dossier is created internally and this dossier is submitted to SCIP. ECHA returns
a SCIP submission No. for every successfully submitted MDS. Potential errors are documented in the column
"Error message".
The next step is the receipt of the SCIP No. for the submitted MDSs from ECHA. This is done in an
asynchronous process since processing at ECHA might take some time until the submission is fully processed
and the SCIP No. is assigned. Completely processed submissions are displayed in the state "Completed".
Links to MDS Details and ECHA
When selecting a submission and right clicking, the below popup menu is opened.

Selecting "Edit" or double clicking the submission, the corresponding MDS Detail window is opened.
If a SCIP Submission No. is already assigned to the submission, the menu "OpenSCIP Submission at ECHA" is
activated. Clicking the menu, a browser window is opened and the web page for the submission on the ECHA
website is shown.
When a SCIP Validation Report exists for the given submission, the menu "SCIP Validation Report" is activated.
Clicking the menu, a browser window is opened and the web page containing the Validation Report on the
ECHA website is shown.
Alternatively, the user can use "drag and drop" to drag multiple MDSs from a source window like the A&R
window into the SCIP Submissions window to initiate the submission of the dropped MDSs.
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REACH Module Description
REACH Analysis
The REACH Analysis is launched by pressing the toolbar button
REACH Analysis.

Clicking on the icon

or using the menu Add-on Modules |

opens a demonstration video on how to use this IMDS-a2 feature.

The module allows the analysis of own and/or received MDS that are not editable anymore (accepted, internally
released, published, …) in the most current version.
Definition of Components to be analyzed can be done “rule based” by a search using the parameters Origin,
Supplier Company & Org.-Unit, Creation date range or by a “non-standard selection” using drag and drop.
The user can choose between the output file formats CSV, XML or XLSX. Sample files for all available formats
can be found in our IMDS-a2 REACH module page on the internet.
The User can choose between two different Report Types:
O5A Compliant REACH Report – This “Quick selection” automatically checks: Components, Subcomponents,
omit branches without SVHC substances, Candidate List (REACH SVHC). Further selections are not possible.
Customized Report – This selection enables further checkboxes and allows the user to customize the report
and to define which types of data sheets he wants to analyze:
• only Component information (with or without Subcomponents) – here the user can also “Omit branches
without SVHC substances”, which means:
− When a component does not contain any SVHC substances, the complete Component MDS is omitted in
the generated REACH Report.
− When a subcomponent branch does not contain any SVHC substances, this branch is omitted in the
generated REACH Report while branches with subcomponents that contains SVHCs are included.
• Component information with Candidate List (REACH SVHC) substances or only with substances from the last
Candidate List update
• Component information with all substances (including REACH SVHC)
• Component- & Materials information
• Component-, Materials- and Submaterial information and
• combinations of the above.
Please select a file name and destination for your REACH report. Report Creation starts by pressing “Analyze”.
IMPORTANT: A BaseFile needs to be available on the server. The first generation of it might require some time.
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If you use the IMDS-a2 without the REACH Module license, you get the following error message when clicking
on „Analysis“:

The user receives the message below after the generation of the REACH Report and its transfer to the user’s
PC. Note that the transfer might need some time due to its size (up to some GB).
Additionally, the user gets the information on the date on which the REACH data is extracted from IMDS.

To make the analysis of data provided with the REACH file easier and to support the REACH O5A perspective,
the corresponding top Node ID is included in every row as well as the Article Node ID, Article Part Number and
Article Name. This illustrates the mapping between components and contained substances. Every (sub-)
component has a unique ID and every substance, which is contained in this (sub-) component, references this
ID.
To support REACH O5A (Once an article, always an article), an additional view on the REACH data based on
the O5A perspective showing weight information for every article in the bill of material is implemented. This O5A
view is available in addition to the existing calculation based on the top component. Additional columns for the
“Top Component Part Number” and the “Top Component Name” also support the O5A perspective.
The CSV version of the REACH Report file contains different columns as described below for components,
materials and substances.
Reach Basefile Format
COMPONENT
1 Type C (Component)
2 n.a.
3 NodeID of the Component MDS/Module
4 NodeID of the tree node 1
5 Article NodeID
6 State (only for topnode, can be: “-“, “P” (published), “A” (accepted), “I” (internal released)
7 Component Name (EN)
8 Part/Item No.
9 n.a.
10 n.a.
11 Amount (or n.a.)
12 Release Date
13 Measured Weight

1

For the top component values in col3 and col4 are equal.
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14 Measured Weight Unit
15 Calculated Weight
16 Calculated Weight Unit
17 Supplier Company ID
18 Supplier Company Name
19 Supplier Org Unit ID
20 Supplier Org Unit Name
21 ID / Version
22 Proportion of node measured weight to root measured weight
23 Proportion of node calculated weight to root calculated weight
24 n.a.
25 n.a.
26 n.a.
27 n.a.
28 Article PartNumber
29 Article Name
30 Top Component PartNumber
31 Top Component Name

Sample :
C n.a. 2355257 2355257 2355257 I Kotflügel E999 n.a. n.a. n.a. 2008-09-30 950.0 g 820.0 g 32101 REACH-4-it
32103 Production 2355257 / 1 100.0 100.0 n.a. n.a. n.a. n.a. E999 Kotflügel E999 Kotflügel
MATERIAL
1 n.a.
2 Subtype M (Material) or SM (Submaterial)
3 NodeID of the Component MDS/Module
4 NodeID of the tree node

2

5 n.a.
6 n.a.
7 Material Name (in EN)
8 Int. Material No.
9 Std. Material No.
10 Classification Code
11 Classification Name
12 Release Date
13 Weight
14 Weight Unit
15 n.a.
16 n.a.
17 Supplier Company ID

2

Value is -1 in case the MDS/Module is not visible for the user.
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18 Supplier Company Name
19 Supplier Org Unit ID
20 Supplier Org Unit Name
21 ID / Version
22 Proportion of node weight to root measured weight
23 Proportion of node weight to root calculated weight
24 n.a.
25 n.a.
26 n.a.
27 n.a.
28 n.a.
29 n.a.
30 n.a.
31 n.a.

Sample:
n.a. M 2355257 2355246 - - Stahl - - 1.2 Cast iron 2008-09-30 200.0 g n.a. n.a. 32101 REACH-4-it 32101
REACH-4-it 2355246 / 1 93.78378378 99.986 n.a. n.a. n.a. n.a. n.a. n.a. n.a. n.a.
SUBSTANCE
1 n.a.
2 Subtype S (Substance)
3 NodeID of the Component MDS/Module
4 NodeID 3 of the Substance
5 Article NodeID
6 n.a.
7 Substance Name (in EN)
8 CAS No.
9 EU Index
10 GADSL Flags
11 Einecs No.
12 Release Date
13 Weight
14 Weight Unit
15 n.a.
16 n.a.
17 n.a.
18 n.a.
19 n.a.
20 n.a.
21 n.a.
22 Proportion of node weight to root measured weight
3

Value is -1 in case the substance is not visible for the user.
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23 Proportion of node weight to root calculated weight
24 Article Weight
25 Article Weight Unit
26 % Article Measured Weight
27 % Article Calculated Weight
28 Article PartNumber
29 Article Name
30 Top Component PartNumber
31 Top Component Name

Sample:
n.a. S 2355257 1762 2356368 n.a. Iron 7439-89-6 - - 231-096-4 - 194.0 g n.a. n.a. n.a. n.a. n.a. n.a. n.a.
20.42105263 23.65853659 194.00 g 20.42105263 23.65853659 007 PreTest 1234 ArtTest

REACH Report
To start the REACH Report select the submenu REACH Report from the menu Add-on Modules.

There are three report types in the report format list: report about IMDS contact persons, REACH contact
persons and used SVHC substances.
In order to generate IMDS/REACH contact persons reports, user can make choice between two different views:
„supplier“ and „customer“, which corresponds to the report about IMDS/REACH contact persons of supplier or
IMDS/REACH contact persons of customer respectively.
For the SVHC report the “Point of view” selection is deactivated.
For report generation click the “OK”-button.
After successful generation and transfer of the report to the customer’s PC the generated report will be shown
to user.
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IMDS contact persons report with pre-selected view „supplier“

IMDS contact persons with pre-selected view „customer“

REACH SVHC report
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REACH Contact Persons
For finding REACH contact persons select the submenu Contact Persons from the menu Add-on Modules.

Clicking on the icon

opens a demonstration video on how to use this IMDS-a2 feature.

The user can start the search for REACH Contact Persons directly by providing the necessary data for
Company/Last name/First name/Person ID – input fields and pressing the “Search”-button. The search result
will be shown in the table at the bottom of search contact person window. By double clicking on one of the table
entries appropriate detail data of the selected item will be shown to the user in the “Contact person data”-tab.

In case the user does not know exact search criteria data the “Search”-button behind the Company field can
help finding the desired company.

By marking an entry from the result table for company search and clicking the „Apply“/”Apply & Close” button,
the corresponding company name of the pre-selected item will be taken over to the company input field in
Search REACH Contact Persons Window. In this case user can return to the Search REACH Contact Persons
Window and continue the search progress.
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Administration
Language
The Administration > Language menu allows you to change the language without logging off IMDS. Changing
the language will refresh the screen so that everything will appear in the selected language. It will not only affect
the language of labels and layout elements, but also the default language for Material MDS names, the
language of the check result and the languages the Recommendation documents.

You can change the language either using this menu or the User Settings item. The language names appear
the same way (and order) as on the login page.

Personal Settings
In this section you can keep your profile up-to-date. You can change your Last name, First name, Telephone
number, Fax number and E-Mmail address. You can see, if Confidential Substances of your own company are
visible to you or not. This access right can only be changed by your company administrator. You can decide,
whether your Personal Data should be displayed for the Trust User functionality and/or when you reject an MDS
or not. And you can change the application language here, too.
You can also subscribe to the email service from IMDS – this means you can chose in which event (concerning
Status changes of MDSs or MDS Requests) you would like to get notified by email. Please note that all emails
are computer generated from IMDS-Info@mdsystem.com and your environment must be set up to receive
emails from the system.
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Furthermore, you get a list of Company Administrators of your company, with their related contact information to
contact them if you need. You can also print the Company Administrator list for later use.
When you click on “Print” you get the following screen:

News
The Administration > News menu displays the News window that lists information published by the IMDS team –
e.g. upcoming events, system downtime, etc. You can mark the checkbox, to “Do not show this news entry
again at startup.

Contact Person
The Administration > Contact Person menu is only visible for Company Administrators and allows them to
create and manage the company’s contact persons as known from the IMDS web application.

User
The Administration > User menu is only visible for Company Administrators and allows them to create and
maintain the company’s users as known from the IMDS web application.

Profile Maintenance
The Administration > Profile Maintenance menu administers your profiles used for Examiner and Inbox
Automation. This has been already described in chapter “Profile Maintenance”.

Recommendation
The Administration > Recommendation menu item shows all available IMDS Recommendations. This window is
also accessible by clicking on the Recommendation button from the Ingredients tab of an MDS. When
accessed in this manner, the Validity date will be populated with the Release Date of the MDS that accessed
the window.
The Recommendations can be searched by:
Validity date

shows the Recommendations valid at this date

last Version

shows the currently valid Recommendations

all

shows all available Recommendations
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.

The documents will be opened in a separate window with pdf or winzip. Please note that only one .pdf window
can be opened at a time from a2 so should you wish to view a second Recommendation, the first window will
have to be closed or an error will be generated.

Options
The Administration > Options menu item allows you to configure certain parameters to personalize your a2
experience. The parameters are stored on your PC so if another PC is used with the same ID, the configuration
will have to be reset on that PC.
There are three (3) areas where you have options you can configure: Dashboard, Export, and Datasheet.

Use ‘OK’ to apply the changes and use ‘Cancel’ to discard the changes.

April 2022

IMDS-a2 Version 13.2

Page 125 of 142

User Manual

IMDS-a2

Dashboard Options

The parameters configure the MDS and MDS Request Dashboards.

MDS Dashboard
Incoming MDS tolerance

The number of days you allow as tolerance since the last status
change of received MDSs.
If you want to have received MDS in the red status after 22 days,
enter 22 as tolerance.

Outgoing MDS tolerance

The number of days you allow as tolerance since the last status
change of sent MDSs.
If you want to have rejected MDS in the red status after 30 days,
enter 30 as tolerance.

Yellow limit

The range used for sorting the MDS to the red-yellow-green due
date status in days.
Red = due today
Yellow = due between today and ‘yellow limit’ days
Green = due later than ‘yellow limit’ days

MDS Request Dashboard
Yellow limit

The range used for sorting the MDS-Requests to the red-yellowgreen due date status in days.
Red = due today
Yellow = due between today and ‘yellow limit’ days
Green = due later than ‘yellow limit’ days

Start Dashboard Automatically
Start dashboard automatically

If checked, the Dashboard will start automatically every time, you
log into a2. Depending on the amount of data associated with your
IMDS company, it may take some time to populate the Dashboard.

Export Parameters

This tab allows you to configure how your export files will be separated.

Delimiter
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Datasheet Options

This option allows the user to set parameters impacting the datasheet.

Switch to ingredients tab
automatically
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Summary of Available Functions
The following section lists the menu functions.

File Menu
Menu

Description

New

Allows the creation of a new datasheet or module.

Save to IMDS server
as

Transfers the current datasheet / module to the IMDS server and …

… current version

… saves it there under the current version number. The MDS/module must
exist on the IMDS server and be in edit mode.

… new version

… saves it there under a new version. The version number is increased
following the IMDS rules. The MDS/module must exist on the IMDS server
and have been created by your company.

… new Datasheet

… saves it there as a new datasheet / module in version 0.01. This function
can also be used to copy an existing MDS/module regardless of the owner
of the original datasheet.

Copy

Copy the version saved on the IMDS database of the current MDS

… copy as new
version

… as new Version - The MDS/module must have been created by your
company.

… copy as new
datasheet / module

… as new MDS/Module

… Forward

… as a forward a copy of an accepted datasheet

Delete MDS

Deletes the current MDS/module on the IMDS server. This cannot be used
on a datasheet that was not created by your company or a datasheet that
has been accepted by a recipient.

Mark MDS

Users with the appropriate access rights may mark own MDSs as obsolete
here or click on “Mark as unobsolete” to remove this flag.

Open from file …

Opens a datasheet or module that was previously saved on your PC.

Save to file

Saves the current datasheet/module to your PC. In case you have not
defined a name you will be prompted for one.

Save to file as …

Saves the current datasheet/module on your PC and allows you to choose
a new file name.

Import

Allows the import of datasheets and/or modules in the special IMDS
spreadsheet format. Currently the “CSV File Version 1.0” format is
supported.

Print

Creates a .pdf-File from the selected report type

Export as CSV…

Allows to export search results as .csv-files

Export as XLSX ...

Allows to export search results as MS Excel (.xlsx) files

Log off

Logs off the current user and brings up the log on dialog again.

Exit

Exits the IMDS-a2 .
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Search Menu
Menu

Description

Component

Starts the Component view/update Window on the Search tab.

Semicomponent

Starts the Semicomponent view/update Window on the Search tab.

Material

Starts the Material view/update Window on the Search tab.

Substances

Starts the Substance view Window on the Search tab.

MDB/Module

Starts the component/semicomponent/material view/update Window on the
Search tab.

MDS Request

Starts the Request view/update/create Window.

CMD Request

Opens the window to search for or create CMD Requests.

In Box

Opens the window for the In Box on the Search tab.

Out Box

Opens the window for the Out Box on the Search tab.

Where-Used Analysis

Opens the window for the Where-Used Analysis on the Search tab.

Basic Substance
Request

Starts the search for initiated basic substance requests.

MDS updates

Opens the window for the MDS Update on the Search tab.

Clear

Resets / clears a frame to show its default appearance.

Search

Starts the search using the entered search parameters.

Regulation Wizard

Opens the window for the Chemistry Manager Regulation Wizard.
Only available for users with appropriate access rights.

Optimizer Menu
Menu

Description

Examiner

Checks the MDS according to the parameters set in the check defined in
the Profile maintenance screen – on the right hand side you find up to 10
last checks carried out

Inbox automation

Calls the Inbox Automation screen to check your incoming MDSs

Dashboard

Calls the dashboard screen

Reports

Starts a separate window in which check criteria can be set and saved

Compare
MDSs/Modules

Calls the Compare screen

Company-specific
Basic Substance Lists

Calls a separate window, where all your company’s specific Basic
Substance Lists with their attributes are listed. Company Administrators
can create new lists and change or delete existings lists for their company.

Add-on Modules Menu (add-on modules need to be licensed separately)
Menu

Description

Analysis & Reporting

Opens a separate Analysis window, where you can define several
parameters for unlimited analysis of your MDSs.

REACH Analysis

Opens the REACH Analysis window in order to find MDSs/Modules
containing REACH-SVHC

REACH Report

IMDS Contact persons, REACH Contact persons or Used SVHC can be
printed into a report
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Menu

Description

Contact Persons

Opens the search for (all) REACH responsible Contact person(s) of a
certain IMDS-registered company

CoChecker Module

Calls the CoChecker screen, where you can export MDSs into XML format.

Administration Menu
Menu

Description

Language

Change the application language without logging off IMDS

Personal Settings

Administer your personal IMDS settings (like email, data protection,
language etc.) and subscribe to the email messaging service of IMDS
(emails in case of status changes for MDSs or MDS Requests)

News

Displays the News window that lists information published by the IMDS
team – e.g. upcoming events, system downtime, etc.

Contact Person

Opens the window to manage the company’s contact persons.
Only available for Company Administrators.

User

Opens the window to manage the company’s users.
Only available for Company Administrators.

Profile Maintenance

Administer your profiles used for Examiner and Inbox Automation

Recommendation

Search for Recommendation versions

Options

Change your personal a2 options for
– Dashboard
– CSV Export
– Datasheet

Windows Menu
Lists the open windows for easy navigation. The currently active window is marked with a *. You can also reset
your window as well as the table settings to the system standard.

Help Menu
Menu

Description

About

Displays the current client and server version of the IMDS-a2.

Online User Manual

Downloads and displays the latest version of the IMDS-a2 User Manual. To
view the User Manual (this manual), the software “Adobe Acrobat Reader”
is required.

Video Tutorial

Opens existing Video Tutorials for different IMDS-a2 functions.

Terms and
Conditions

Downloads and displays the latest version of the IMDS-a2 Terms and
Conditions in the Internet Browser. To view these, the software “Adobe
Acrobat Reader” is required.

Terms of Use

Downloads and displays the latest version of either the IMDS or the CDX
Terms of Use in the Internet Browser. To view these, the software “Adobe
Acrobat Reader” is required.

April 2022

IMDS-a2 Version 13.2

Page 130 of 142

User Manual

IMDS-a2

Installation
The IMDS-a2 is an application service developed in the Java programming language. For that reason a
Webstart software needs to be installed on each client PC in order to run a2. OpenWebStart is a license free,
Open Source software, which doesn’t require the installation of a Java Runtime Environment on the local PC. In
case of a missing Java, OpenWebStart automatically installs the license free, Open Source product OpenJDK
11.
If OpenWebStart is already installed on your PC, go directly to chapter “Launch the IMDS-a2”.

Installation of OpenWebStart
Hint: Depending on your PC configuration and operating system you might need Administrator permissions to
install software. In this case please contact your system administrator to execute the installation.
Start your web browser (e.g. Internet Explorer) and go to the URL https://openwebstart.com/download
Here you can download the installation file (e.g. OpenWebStart_windows-x64_1_1_6.zip) as a zip file
containing an executable file. A Java Runtime installation is not required at all. Executing the installer, the
following dialogs appear:

Begin with the installation:

Accept the license agreement:
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Determine user audience:

Define installation directory:
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Let OpenWebStart handle the extensions .jnlp and .jnlpx:

Installations begins:

April 2022

IMDS-a2 Version 13.2

Page 133 of 142

User Manual

IMDS-a2

Completed:

Launch the IMDS-a2
The IMDS-a2 is launched by opening the URL https://www.mdsystem.com/webstart/imdsloader/imdsloader.jnlp
in a browser.
Here in Chrome (including the warning for JNLP execution):

OpenWebStart gets launched:
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It detects that no OpenJDK runtime environment is available and automatically downloads and installs
AdoptOpenJDK version 11:

And then launches the embedded Iced Tea implementation which represents the Webstart:

The IMDS-a2 software version is checked and downloaded in case an updated version is available on the IMDS
servers:

The DXC Code Signing certificate gets validated and you can choose to trust the certificate and execute the
application:
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You can also configure the creation of a desktop icon and a menu entry:

During the first startup OpenWebStart will then create an IMDS-a2 icon on your desktop:

and a menu entry IMDS | IMDS-a2 Optimizer to launch or uninstall the IMDS-a2:

You can launch the IMDS-a2 later by double clicking the icon or using of menu entry.
Finally, the IMDS-a2 application launches completely:
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Update of a Java Runtime Installation
In case OpenWebStart detects that an update of the Java Runtime environment is available, you are asked, if
you want to install the new Java version:

Click “Yes” to get the new Java version downloaded and installed on the your PC. Administrator rights might be
necessary.

Right after the installation the IMDS-a2 application is launched.
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Potential Problems
Manual Entry of a Proxy Server

The IMDS-a2 is using the Webstart software to ensure that you are working with the latest version of the IMDSa2. For this reason OpenWebStart needs to access the IMDS server over the internet.
Most companies are using a proxy server to provide access to the internet. Normally Webstart reads the
required proxy settings from an installed web browser. This process might fail for some browsers (typically only
for uncommon ones) or if your company uses an automatic configuration script instead of proxy server settings.
In this case the proxy settings must be entered manually in OpenWebStart.
Launch the OpenWebStart Settings:
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Click on”Proxy Settings“ and choose the correct proxy. For “Manual proxy” enter the name of your proxy server
and port in the proxy address.
Hint: You can get these settings from your system administrator or read it out of an configured web browser.
E.g. IE: menu ”Tools“ > ”Internet options“ > tab folder ”Connections“ > button ”LAN Settings“ >”Advanced“.

You must confirm the changes by pressing ”OK“.
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File imdsloader.jnlp cannot be loaded

After successful installation of Webstart the https://www.mdsystem.com/webstart/imdsloader/imdsloader.jnlp
cannot be loaded.
This can have several root causes:

Temporary memory (Cache) holds old files

Empty your internet browser cache as well as your OpenWebStart cache.

Browser cache

e.g. Microsoft Internet Explorer: Tools > Internet Options > General > Delete (Browsing history)

OpenWebStart cache

Launch the OpenWebStart Settings:
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Other important settings

Personal firewall blocks access

If you have a Personal Firewall installed on your PC, this must be set up in a way that it allows access to the
Java process into the internet (the IMDS-a2 runs with such a process).

No IMDS-a2 icon on your desktop

In case no IMDS-a2 icon was created on your desktop:
Go to the Windows menu entry IMDS and drag the IMDS-a2 Optimizer
application to your desktop. You can also use right mouse-click to “Pin
to Start”.
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Further Support
For questions concerning all administrative and technical features we provide an email address:
mds-solutions@dxc.com
The IMDS-a2 support team will post a reply to your questions as soon as possible.

Contact Information

DXC Technology Germany
EntServ Deutschland GmbH
IMDS Advanced Solutions
Alfred-Herrhausen-Allee 3 – 5
65760 Eschborn
Germany
dxc.technology
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